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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

#'¢%, RAW image data

Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images
Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trimming and adjusting the angle of an
image

Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

Introduction

oS Mac OS X 10.6 to 10.7
Computer | Macintosh with one of the above OS installed
CPU* Intel processor C: r(natfanl:(s:eat
RAM Minimum 1GB
Displa Resolution : 1024 x 768 or more s
piay Colors : Thousands or more opeﬁlfon
* Core2 Duo or higher is recommended
This software program is not compatible with UFS (UNIX File System)
formatted disks. Advanced
Check the Canon Web site for the latest system requirements, Operation
including supported OS versions.
Advanced
Supported Images oI
. L and Printing
This software supports the following image types.
Image type Extension Processing ‘
RAW images*! shot with EOS DIGITAL La;gﬁrﬂgg‘g:’s
cameras, excluding EOS DCS1 and .CR2
RAW images | EOS DCS3 TIF -
RAW images*2 shot with PowerShot .CRW Jlfggll?ﬁ:F
cameras Images
JPEG images EX|f2.2, 2.21 or 2.3-compatible JPEG JPG, JPEG
images
TIFF images | Exif-compatible TIFF images TIF, .TIFF BEIBIE
*1 Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension. Index
For information on CR2 Converter, refer to Canon Web site.

*2

» Only models where Digital Photo Professional is listed in the “Data
Type” item in the “Specifications” section near the end of the
Camera User Guide.

* Use the dedicated CameraWindow application to download images
from a PowerShot camera to a computer. See the Software Starter
Guide for details.

* Lens aberration correction can only be used with some camera and
lens models.

» Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.
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Downloading Images to Your Computer Auto correct RAW images with the Auto Lighting Optimizer =» p.61
Download images by connecting your cameraand - Adjust brightness of shadows/highlights = p.57 Contents at
computer ' Reduce image noise = p.62 a Glance
Download images using a card reader =p.9 Correct lens aberration - p.63
.. . Use the Digital Lens Optimizer - p.69 Basic
Viewing and Checking RAW Images Use a Pictl?re Style ﬁlep S E o Operation
Quickly enlarge parts of an image - p.11 Edit efficiently > p.34
S9ﬂ Images (check marll<s, rating) 2 p-18,p.19 Edit an image while comparing the image before and -, deantc_:ed
Display an image shot simultaneously as a RAW - p22 after adjustment P. Eeravbiy
image and JPEG image as a single image Synchronizefultiple images - p54
Display the images in the thumbnail list display at high -»p23 Display’an afea Beyond the set range as a warning Advanced
resolution ' I "R . - p.55 Image Editing
indicator (Highlight/Shadow warning) and Printing
Check shooting information such as the shooting date =» p.10, p.23 Réstoréan adjusted Image to its condition at the time
oy . e of shooting 7 Processing
Editing RAW Images (Adjusting) Composite images »p78 Large Numbers
. . of Images
Adjust brightness/darkness = p.12,p.26 Create HDR (High Dynamic Range) images - p.82 J
Use automatic adjustment - p.33
Change the Picture Style -» p.26 Printin JPEEd(I;t/I?lgFF
Sharpen the modulation and contrast of colors (contrast) = p.29 . 9 _ Images
Make skin tone look healthier (color tone) - p.29 Prl.nt well on a Canon printer . = p-43, p-88, p.90
Make the image colors more vivid (color saturation) =» p.29 Falthfully rfeproduce the color of the subject =» p.43, p.88, p.90
_ when printing Reference
Make an image sharp (sharpness) < p31 Print with the shooting information =» p.86
Adjust an image to make color tone more natural . - :
(white balance) =>p.27 Print a thumbnail list of images -» p.87
Change an image to black-and-white or sepia tones ~ _, - Approximate the color seen on screen with your p.94 e
(monochrome) p. printing results
, . , . >0 _
Trim tam image and a<.jjust the angle of an |.mage p.38 Conversion of Images
Specify an aspect ratio that matches the size of the - 038 ) )
paper on which an image is to be printed P. Convert a RAW image to a JPEG image = p.42, p.101
Erase dust shot with the image - p.73,p.75 Edit in Photoshop = p.78, p.102 @
Erase unwanted parts of an image - p.77 Perform batch processing = p.101
Edit (adjust) a JPEG image -» p.105



1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.

)
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Starting up DPP

Click the Dock icon.

Digital Photo Professional

"’. 13 Elﬂ . Click

T ﬂ'l—",y\

DPP starts up and the main window ([Folder] window) appears.

v

Main wmdow ([Folder] window)

( . mg ial Phota Professional  Fiie Bookmith  Latel  Admitmers  Tooh  Widew Pl w4 mdEaaM @

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.36)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.

[Folder] window

R R W v e O
ity .

@ ® @® D -s.s..rg

...........

[CoIIectlon] wmdow

[T oot P Frofussmmal o i Torme L Al
Lali]
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Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility”

from DPP and use.

Select the save destination for the images.
Select the save destination in the folder area on the left of the

main window.
When creating a folder, see p.50.

8006

i3

Folder Collection(0)
v =4 MacOsx
P & Applications
[C7 Temporary ltems
¥ [& Users
v @& canon
» [@F Desktop
» |1 Documents
» (& Library
\® Movies
L& Music

» [ 1 Sites
» [F shared

Digit

Start up EOS Utility.

Select the [Tools] menu » [Start EOS Utility].

Start Quick check tool MCHF

Start Trimming/Angle Adjustment 1

r Rename ront

Start EOS Utility HE

EOS Utility starts up.

EOS Utility (Some displayed items differ when an EOS M is

connected)

ann EOS Utility

Control Camera Accessories

Starts to download images
elect and download images

Camera settings /Remote shooting

“ Monitor Folder
o
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Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Ultility Instruction Manual” (PDF
electronic manual).

Accessories

Starts to download images

'ﬁl Lets you select and download images
=

I@ Camera settings/Remote shooting
“ Monitor Folder
o

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-I\@/E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

5

You cannot start up EOS Utility in the [Collection] window

(p.6, p.36).

When EOS Utility has been started up from DPP, you cannot use

the following functions.

* Quick check window view (p.16)

» Trimming and adjusting the angle of an image (p.38, p.113)

*Digital Lens Optimizer (p.69)

» Compositing images (p.78)

* Creating HDR (High Dynamic Range) images (p.82)

* Dust erasure processing (copy stamp function)
(p-73 to p.77, p.116 to p.120)

» Batch change file names (rename function) (p.103)

* Printing with shooting information (p.86)

* Printing a thumbnail list (contact sheet printing) (p.87)

* Printing using Easy-PhotoPrint EX or Easy-PhotoPrint
(Plug-in printing) (p.43, p.46)

* Transferring images to Photoshop (p.78)

* Batch saving images (batch processing) (p.101)
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Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

Open a removable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place
such as to the [Desktop].

a00 Digital Photo P

Folder Collection(0)
¥ =4 MacOSX
> A Applications

|7 Temporary Items
¥ (& Users
v @ canon

P [ Library
= Movies
[# Music
» = Pictures
» (& Public
> [ Sites
» | I Shared
¥ . EOS_DIGITAL
» 1 DCIM

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.

In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

808 Digital Photo Profession

i,

Folder Collection(0)

v 2 MacOsx
» |4 Applications
[F Temporary Items
¥ |& Users
v & canon
v [ Desktop
¥ [

|7 100CANON
|7 102cANON @
» [ Documen its IMG_0001.CR2
> [ Library
= Movies

Be

& Music
» |2 Pictures

Images in the folder are displayed in the main window of DPP.

-Z\@/E Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the

folder are displayed in DPP and you can check the shot images.

5

Copying to your computer may take time when there is a large
number of shot images saved in the memory card.

For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).

Introduction

Contents at
a Glance

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©




Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list

in the main window. You can double-click an image to open the edit
window and display the image at large size.

View Images as Thumbnails in the Main Window

L Rotate selected image
Main window ‘

s 4 s s ||

Click to select the image ‘
Display thumbnails of all the images inside the
folder selected in the folder area on the left

@ Images displayed with the ["® ] icon are movie files and cannot
be played back in DPP. Please use “ImageBrowser EX”, which is
compatible with EOS DIGITAL movie files.

If the message [Insufficient memory.] appears, there are too many
images in one folder. Decrease the number of images in one
folder such as by dividing them into smaller folders.

|§| When aspect ratio information is attached to the shot image with the EOS-
1D X, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 5D
Mark 11, EOS 6D, EOS 7D, EOS 60D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D or EOS M, the image is displayed as a trimmed image
(p.38, p.113).
For a list of main window functions, see p.126.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

View
Edit in Edit image window H—
View collections NHG

v Tab

v Folder view

v Toolbar
Tool palette T
Large thumbnail #1

v Medium thumbnail 2
Small thumbnail 3
Thumbnail with information ¥4
Sort 3

The display changes to the selected item.
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Enlarge and View an Image in the Edit Window

Double-click

The edlt wmdow appears.

Edit window '

TooI palette

* W GO

[ e i

It may take time for the image to redraw itself.
Click the [@] in the upper left of the edit window to close the edit
window.

By selecting the [View] menu » [AF Point] in the edit window, you can
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images whose image size
has been changed and then been converted and saved (p.42, p.136),
images for which you selected an effect other than [Shot settings] as
correction of fisheye lens distortion aberration, or images which have
had settings specified during RAW processing on the camera for
distortion correction and chromatic aberration correction.

For a list of edit window functions, see p.129.

Enlarging and Viewing a Specific Area
Double-cllck the area you want to enlarge.

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

© Double-click again to revert to the full view.

® To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

— Change the enlargement
display position by
dragging

5@/5 To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.92).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [ ]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette

[ RAW | RGB MR/ALO LENS

— .
|En’ghtness adjustment ln - || Reverts the Image to
. ...’_\| S ow the original settings
|Whita balance adjustment =) || D_rag the Sl|der Ieft or
— — right
[ sl
| Shot settings B0 Tune.. )
Picture Style |
Standard | i] lll Browse... |

e S

T

100 B0 -BD -40 -20 0 20 40

Contrast: 1o “_@f‘
Highlight: e s, v s
Shadow: S A
! Linear
Color tane: (0) _E}T
Color saturation: L] T@:T‘
Unsharp mask ! :]
Strength: (] eﬁ
Fineness: 0 Qﬁ
Threshold: 1) E"r—..-

The image brightness changes in real time according to the
amount of adjustments.

? The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette are saved to an image as data
called a “Recipe” (p.98).

@ For a list of tool palette functions, see p.130.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Close window HEW
[ save IS
Save As... i 35S
Convert and save... #D
Page setup... {r 3P
Print... 3EP
Print with detailed setting... {r 3D
Contact Sheet Prints... ~ 3P
Plug-in printing >
Info... 4|

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method, see
Chapter 2 onwards.

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.23)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.42)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.101)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.

Introduction

Contents at
a Glance

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

13




Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Close window HEW
Save a5
Save As... i3S
Convert and save... ®D
Page setup,., {r 3P
[ Print.. 3P )
Print with detailed setting... 43D
Contact Sheet Prints... ~3EP
Plug-in printing b
Info... |

The [Print] dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.

-Z\@/i- To change the paper size

To set the paper size etc., select the [File] menu » [Page setup].

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
see Chapter 2 onwards.

Print one image (p.49)

Print using a Canon inkjet printer (p.43, p.46)

Print with a high-end Canon printer (p.88)

Print with shooting information (p.86)

Printing a thumbnail list (contact sheet printing) (p.87)

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu » [Quit Digital Photo

Professional].

\ 'Digflal Photo Professional

About Digital Photo Professional

Preferences... o
Service >
Hide Digital Photo Professional 3H
Hide Others H#H

[ Quit Digital Photo Professional EEQ)

DPP quits.

|§| A confirmation dialog box for saving the images appears when you
try to quit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........cc.c............ 16
Sorting IMages........uuueeiieeieeeeeeeeeeeeeeeeeeeeeeeeeeeeee 18
Attaching Check Marks.........cccccccoeeeiiieeiiiiinieeenne... 18
Setting Ratings ......ccoovveiiiiiiiiieeeeeeeeeee, 18
Sorting Images in the Main Window ..............c........... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window...................... 20
Arranging by TYPE ....uuuuiiiiiiiieiie e 20
Arranging Freely .......ccoooovvoiiiiiiiiieeeeeee 21
Displaying a RAW Image and JPEG Image as a Single
IMAGE ... oo 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information................cccccovvvveeennn. 23
Editingan Image ..., 25
About the RAW Tool Palette..........ccccceeeeeeeeeeeeeennnnin. 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightness...........ccoooiiiiiiiiiiiiiiiieeeeeeeeeeee, 26
Changing a Picture Style ..........cccccccooeeeeiiiiiiiieeeee. 26
Picture Style File..........ocooiiiiiiiiiiiieeeeeeee 27
Adjusting Color Tone by Changing White Balance.... 27
Adjusting Color Tone Using Click White Balance...... 28
Adjusting Contrast ..........ccccoiiiiiiiiiiieee e 29
Changing Color Tone and Color Saturation............... 29
Adjusting Monochrome ..........ccccccoiiiiiiiiiiiiieee . 30
Adjusting Image Sharpness...........cccccccviiieiieeeneeenn, 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
Curve AsSist) ... 33

Editing Efficiently ... 34
Editing in the Edit Image Window...............ccvvvveeee.... 34
Changing the Thumbnail Display Position to a Horizontal
POSItION ... 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing Results............cccccoiiiiiiiii 41
Saving Editing Contents to a RAW Image................... 41
Saving as a JPEG or TIFF Image.........cccccveeeeeeeeennn. 42

Re-Editingan Image........cccccoovviiiiiiiieeee 43

Printingan Image ... 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX ......................... 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint...................c........... 46
Printing Photographs with a Printer other than Canon
Inkjet Printers..........cccoooiiiiiieee e 49

Organizing IMages .......ccceeeieiieeiiee e 49
Deleting an Unwanted Image ..............occcociiiieeennnn.n. 49
Creating a Folder for Saving Images..............ccc........ 50
MOVING IMAQES .....oeeeeiiiieeee e 50
Moving Images in Folders ...........oovviiiiiiiiiiiieeeeees 51
Registering Frequent-Use Folders (Bookmark
Registration) .........cccccooeiiiiiii e 51

Organizing Bookmarks ..........cccoevvviiiiiiieeeeeeiiinn. 51
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into five groups.

Display the quick check window.
Click the [Quick check] button.

Digital Photo Professional - [ MacOSX /Users/canon/Piq

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

)

All the images displayed in the main window can be checked in
the quick check window.

Double-click the area you want to enlarge.

Double-click

The area you double-clicked is enlarged to 50% view.
To change the display position, drag on the image.
Double-click again to revert to the full view.

2 To quit, click the [OK] button.

@ When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF points
are not displayed for images which have had their image size
changed and then been converted and saved (p.42, p.136), which
have had settings specified during RAW processing on the camera
for distortion correction and chromatic aberration correction, which
are composited, or which are created as HDR (High Dynamic
Range) images.
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> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <38> + <—>or
<3E> + <> keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.92).

For a list of quick check window functions, see p.134.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [%] to [5].

Check mark

[ Clear }

12345 Click

The selected check mark appears in the upper left of the window.

Check mark

2/15 IMG_0002.CR2 [3456 x 2304] —

| soxwiew [N rull sereen |

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in DPP version 3.8
or earlier are maintained as they are.
You can also attach check marks from the menu that appears by
clicking on an image in the main window while holding down the
<control> key.

Setting Ratings
Display the image you want to rate, and then click
any one of the [ - ].

Introduction

—_—

Contents at

a Glance
—
Rating
i e
[ Reject ] Operation
(s » 2 & ») Click (changes to [ % ] after
clicking [ = ]) dvafced
p ion
The rating is set and an icon corresponding to the selected [ ]
appears in the upper left of the window.
(Window shown with a rating of three [ % ]) Advanced
. . . . . Image Editing
® To set [Reject], click the [Reject] button. Click the [Reject] button and Printing
again to cancel.
Rating icon Processing
Large Numbers
2/15 IMG_00D2.CRZ [3456 x 2304] i | — | Of lmages
Check mark =
e Editing
12345 JPEG/TIFF
pating Images
@ -
To cancel the rating, click the same [ ] as when the setting was Reference
made on the right of the window. —
Index

® As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.

|§| You can also set ratings (including [Reject] setting) from the menu
that appears by clicking on an image in the main window while
holding down the <control> key.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [E¥] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark

frame.

Check mark

Click the check mark in the toolbar again to remove the check
marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [@] in the toolbar.

Click (changes to [E1]
after clicking [H])

- Select

The rating is set and an icon corresponding to the selected [Ei]
appears in the image frame.
(Window shown with a rating of three [Ei] as an example)

rocess

Rating icon

_WCO02CR  |gm WGODSCR2 | n g MCOW0ACE o

To cancel the rating, click the same [E1] as when the setting was
made in the toolbar.

[Reject] cannot be set with the toolbar. Set [Reject] with the
[Label] menu or the quick check window (p.18).
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Y

=@> To select multiple images in the main window

Click on desired images while holding down the < 38> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

-Z\@/i- To display more thumbnails in the main window

You can display a large number of images by setting the size of
thumbnail images to small (p.10). Then, by selecting the [View] menu »
[Rating] and removing check marks so that ratings no longer appear in
the image frame, you can display still more thumbnail images in the main
window.

|§| The [Label] menu can also be used to attach check marks and set
ratings.

By selecting the [Edit] menu » [Check mark] or [Rating] » image

selection criteria, you can refine criteria for selecting

checkmarked or rated images.

You can display and change the rating settings set in DPP with

other bundled software and on an EOS-1D X, EOS 5D Mark IlI,

EOS 6D, EOS 7D (firmware version 2.0.0 or later), EOS 60D,

EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T3/

1100D, or EOS M camera.

» EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

* Onan EOS-1D X, EOS 5D Mark lll, EOS 6D, EOS 7D (firmware
version 2.0.0 or later), EOS 60D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D, EOS REBEL T3/1100D, or EOS M camera:
Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change with DPP the rating

settings set for stillimages on an EOS-1D X, EOS 5D Mark I,

EOS 6D, EOS 7D (firmware version 2.0.0 or later), EOS 60D,

EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T3/

1100D, or EOS M camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type
Select the [View] menu » [Sort] » desired item.
Vir;v (.ol.i.eaio.ns. = TQGG

v Tab
v Folder view

+ Toolbar

Tool palette ®T
v Rating

Large thumbnail #1
¥ Medium thumbnail 382

Small thumbnail 3

Thumbnail with information 34

Rating : Ascending order
Rating : Descending order

v File name
Shooting Date,/Time
RAW priority

Check mark1
Check mark2
Check mark3
Check mark4
Check mark5

The images are arranged in the order according to the selected
item.
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Sort item Description
Rating: ascending Sorted in order of fewest [ ].
order
Rating: descending Sorted in order of most [« ].
order
File name Images are sorted by file name in alphanumeric

order (0to 9 » Ato 2).

Shooting Date/Time Images are sorted by shooting date and time
from the earliest.

RAW priority Images are sorted in the following order: RAW

images - JPEG images - TIFF images.
Check mark1 - Images with check marks take priority and are
Check mark5 sorted in number order.

-Z@/E Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as
follows:

Check mark1 selected: 122->3->4-5

Check mark2 selected: 2-3—->4->5->1

Check mark3 selected: 3»4->5->1->2

Check mark4 selected: 4»5->1->2-3

Check mark5 selected: 5>1->2->3->4

Arranging Freely

Drag and drop the image to the desired location.

107 VW Beolmak Lbe ASuvimest Tooh Wedow Weip W+ we oA @

2@ @20 ®@

The image moves to the desired location.

You can also select multiple images (p.20) and move them.

The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.

Select the [View] menu » [Sort] P [File name] to revert to the
order before the images were rearranged.

:@E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p.92).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.103).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

i Y
Preferences

General sertings || View settings || Tool palette | Color management
——

Grid pitch
64 Pixels(8-256)

Locking selected image
g Images opened in Edit window remain selected in main window

Magnification in Edit window

(®) Fit to window O s0% O 100% O 200%

Magnification when the Edit/Edit image window is double-clicked

@ s0% O 100% O 200%

and IPFC
E Display only CR2 images for CRZ and JPEG files of the same name J

Sort order in main window
g Retain sort order

Highlight/shadow warning

Highlight 255 (192-255) (N
Shadow 0 (0-64) ]
Quick check tool display
® s0% () 100% (moiré reduction off)
f Cancel )] f OK }

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(GZXB] mark (p.128).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-Z\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.49)

* Moving or copying an image (p.50)

» Checkmarks (p.18, p.19)

* Rating (p.18, p.19)

» Rotating an image (p.126, p.134, p.135)

» Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[ 23] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.127).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

Open in Edit window HO
Open in Edit window (enlarged)
Close all
Open window N
Close window EW
Save #S
ye As {7385
' Add thumbnail to image and save {&T ]
Convert and save... E£0
Batch process... #B
Create new folder... {+ 3N
Page setup... {r 3P
Print... 3P
Print with detailed setting... {+#D
Contact Sheet Prints... ~¥P
Plug-in printing 2
Add to collection #G
Remove from collection 4 #EG

-:\@/3 The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

@ A large number of images may take some time to add.

Checking Image Information

Select the image for which you want to check the
image information.

Click the [Info] button.
000

Folder Collection(0)
v = ENG
> & Applications
> ‘I. Developer
» [ Phota 1

The image information window appears (p.24).
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Select a tab sheet and check information.
[Shooting Information] tab sheet

[Metadata] tab sheet

800

_ IMG_0001.CR2

{ Shooting Information | M

1

Aata

| Item

Camera Model
Firmware

Shooting Date/Time
Owner's Name
Shooting Mode

Tw( Shutter Speed )
Av( Aperture Value )
Metering Mode
Exposure Compensation
ISO Speed

Auto 150 Speed
Lens

Focal Length

Image Size

Image Quality

Flash

FE lock

White Balance Mode
AF Mode

Picture Style
Sharpness

Contrast

Saturation

Color tone

Color Space

Highlight tone pricrity
Aute Lighting Optimizer

Dust Delete Data
File Size

Drive Mode

Live View Shooting
Date/Time(UTC)
Latitude

Lonnitude

Long exposure noise red...
High IS0 speed noise re...

Peripheral illumination c...

Value

FileName ___________|IMG000LCR2 I

Canon EOQS XXXX
Firmware Version X.X.X
TR TR b R

Shutter-Pricrity AE
1/1600

8.0

Evaluative Metering

1]

400

OFF

EF70-200mm f/4L USM
188.0mm

prteseeied

Auto

Manual focusing
Landscape

4

1]

1]

1]

sRGB

0:0ff
0:5tandard
0:Disable
3:Disable
Disable

No

KAHKKB
Continuous shooting
OFF

r R

8,00  IMG_00D01.CR2

" Shooting Information | M

Description

[Document Title]
XXANKAAK

[Author]

XXANKAAXK

[Author Title]
XXANKAAXK
[Description]
XXANKHAKX
[Description Writer]
XXANKAKX
[Keywords]
XXAXKHAAXK
[Copyright Status]
HXAXKHAK
[Copyright Motice]
HXAXKHAK

[Copyright info URL]
HXAKKHAK

o

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image after
shooting is displayed in the [Metadata] tab sheet.

IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [Metadata]
tab sheet.

IPTC* information can only be appended to JPEG/TIFF images
using Photoshop (CS3 or later).

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

Y
~
NS

Convenient uses in the main window

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window

Tool palette

WG
sy

|y e o e 3 Lrye

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <3f> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.53).
You can synchronize multiple images and edit while comparing
them (p.54).
See p.129 for a list of edit window functions, and p.130 for a list of
tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/ALO] and [LENS] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool palette] button (p.126) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

Reverts the image to

’]]7 the original settings

[ RAW | RGB = MNR/ALO  LENS |
|Erighmess adjustment [ b
L -]
(- = =
.|--|:--|-:Q.2---||--|--l "'DD’
|While balance adjustment | B !|
7]
j Shot settings f :] " Tune..

Enter a numerical
value

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochrome].

|F‘icture Style &_-b_: '—l Reverts the image to
- the original settings
[ Standard &= ]}, Browse... | Select

e S o

]

h—lﬂ_ﬂ =30 -6.0 -40 -20 0 20 4.0

Contrast: 1 E o
Highlight: AEM 6 i
Shadow: 10) ...||3.---||

Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.93).

[Auto] is only applied to images shot with the EOS-1D X, EOS 5D
Mark Ill, EOS 6D, EOS REBEL T4i/650D, EOS REBEL T3i/600D
or EOS M.

When changing a Picture Style with several images selected, you
can select [Auto] if images shot with the EOS-1D X, EOS 5D
Mark 1ll, EOS 6D, EOS REBEL T4i/650D, EOS REBEL T3i/600D
or EOS M are included. However, [Auto] is actually applied only to
images shot with the EOS-1D X, EOS 5D Mark Ill, EOS 6D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D or EOS M.

You cannot select [Auto] with multiple-exposure RAW images
created on the camera.
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Picture Style Description

Standard The image looks vivid.

Ordinarily, this setting is suitable for most images.

The color tone will be adjusted to suit the scene.
The colors will look vivid, especially for blue skies,
greenery, and sunsets in nature, outdoor, and
sunset scenes.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.29).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [].

Auto

Portrait

Landscape

Neutral

Faithful

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Picture Style File

A Picture Style file is an extended function file of Picture Style. See p.59
for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

[ RAW | RGB = NR/ALO = LENS
‘Erighmess adjustment iy :‘
-|--|:--|--:Q?-|--||--|-- 0.00
‘White balance adjustment l - f} Reverts the image to
A ' 3 |( Register. the original settings
[ Shot settings | :]) Tune.. |
Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.28).

Y
~Q= Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.29) to get closer to your
requirements.

® You cannot register the adjustment results as personal white
balance (p.100) when you have selected [Shot settings] from the
list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

[ RAW | RGB | NR/ALO LENS
|Erighmess adjustment — |
||||||||||Imlllllllllll E-DD
White balance adjustment | B |
A _' 1 ! 2 | 3 |[ Register. n .
=___ = Click
Shot settings I--.:] ( Tune.. |

Click on a point that is to be the standard for white.

(ITar Do Pt Pl | s T e o Pt s U, BG83 1

=Lt

Reverts the
The coordinates of the cursor position and the image to the
RGB values (8-bit conversion) original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

|
|t S [ ® [ Reverts the image to
the original settings

Standard i:]( Browse...

e s = e <

A

rh—l[l'_t] -8.0 -60 -4.0 -20 .0 2.0 __4.0

Cantrast

: (0 ﬁ Drag the slider left or
Highlight: {1 e—— re—— right (9 steps)
Shadow: {0) 'I_”e'f
! Linear
Color tane: i) _6_-
Color saturation: 10 "_@—
Unsharp mask (B ]
Strength: 10) 6-—-
Fineness: o) 9-—
Threshold: ] e—'

Displays the value of the setting

-Z\@E [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

|§| The Auto Lighting Optimizer (p.61) will not function when [Linear] is
checkmarked.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.30).

| icture Style [ ® Jl——Reverts the image to
the original settings

Standard i¢]|’ Browse... |

ey =S e o

]

100780 -60 -40 -20 0 20 40

Contrast: {0 '_@'_‘
Highlight: {m 9
Shadow: {0) E?
! Linear
Calor tone: 0 ——I—%T Drag the sliders
Color saturation: 100 — left or rlght
' Unsharp mask ‘]
Strength: {0) 6’"
Fineness: {0) 9
Threshald: (o EE‘

Displays the values of the settings

Color tone: Mainly used for adjusting skin tones. Move the
slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

Color saturation: The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

| Pcture Style [ = | Reverts the image to
\ the original settings

' Monochrome IQ]{’ Browse... |

¥ - a

A

T10.0 S80 -60 -40 -20 0 20 440

Cantrast: a '_Q_
Hightight: 0 e i—
Shadow: 0 "_@—
! Linear
Filter effect: (None)| T AT Drag the sliders
Toning effecr: {Mone) T J left or rlght
Unsharp mask ]
Strength: (] e..—-
Fineness: 10) ‘\:}ﬁ
Threshald: (4]} m

Displays the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

Y
N

=)= Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image harder or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].

[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.

[Threshold]:  Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

Select [Sharpness] from the list box and make the
setting.

s (E3 }J— Reverts the image to
the original settings

| Standard F$1( Browse.. )

s d

100 -8.0 -60 -48 -20 0 2.0 40

Contrast: 1 '_@'.—
Highlight: ey sy
Shadow: o F_..QT
| Linear
Color tone: o F—@_.-
Calor saturation: 10) T‘\:}T
| sharpness Select [Sharpness]

Sharpness:

brag the slider left or right

Displays the value of the setting

@ The adjustment range is 0 to 10 (in 1-stop increments).
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Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and make

the setting.
|Pi|:ture Style = ||
' Standard | #] [ Browse.. )

",

&

100 8.0 60 40 20
Cantrast:
Highlight:
Shadow:
! Linear
Color tone:

Color saturation:

( Unsharp mask

Select [Unsharp mask]

Strength:

Fineness:

Threshold:

Displays the values
of the settings

Drag the slider left or right

? The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view],
[100% view] or [50% view]. If the view is set to [Fit to window] (full view),
the effects of adjustment may seem unnatural.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.145). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired

automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

MR/ALO LENS ©

Tone curve assist

__ - Reverts the tone curve

Tone curve adjustment | to the original settings
T RGE ] R |G |—3| !?]
255 2L High
Standard
D J
0 255
Eﬁghtﬂﬂ!s: ||||||||||5.|||||||||| D:.
Contrast:
Huee:
Saturation:
Sharpness:

The tone curve changes as adjusted.

|
\\/

== Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

(D Ifyou click the [(E25]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.109).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

2@ ® ®

Clear all

¥ 2§ ENG
b | A Applications ;
L ln Developer .
[Z photn i

Click

The main window switches to the edit image window.

Edit the image.
Change the size
Edit image window

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

@ By selecting the [View] menu » [AF Point] in the edit window or edit
image window, you can display the AF points selected in the camera
at the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.42, p.136), images for which you selected
an effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction and
chromatic aberration correction.
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Double-click the area you want to enlarge.

e 100 A @

-I@/E To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

— o @ You can change the way the tool palette is displayed (p.93).
You can change the enlargement ratio when you double-click
(p.92).
With the edit image window, you can only select images from one
Double- . by
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.36).
=g For a list of edit image window functions, see p.135.

2R |
i~ |
g T3

S click

A b . ¢ ad w2 [

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.130) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main Window] button on
the toolbar.
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Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

=

I
|cowem oo v g9m. v ¢ b W b ity

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you

to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

Open in Edit window

Open in Edit window (enlarged)
Close all

Openwindow

Close window

Save

Save As...

Add thumbnail to image and save
Convert and save...

Batch process...

Create new folder...

Page setup...

Print...

Print with detailed setting...
Contact Sheet Prints...
Plug-in printing

#£0

M
W

¥S
{+ 35S
T
#ED
L

{r3EN

{r 3P
3P
13D
~3EP
4

( Add to collection

%G )

Remave from collection

{30

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]

tab sheet increases by 2.

You can select several images and add them to the [Collection]

window.

You can also add images to the [Collection] window by selecting
images, clicking on the image while holding down the <control>
key, and selecting [Add to collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.

800
== i
Folder Collection(14)
v = MacosX

b A Applications

[Z Temporary ltems
¥ | & Users

v @ canon

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

@ Digital Photo Professional File Edit  View Bookmark Label Adjustment Tools Window Help
ann Dégital Photo Professional - [Collection]

oA Wed b A @

_Adsbe KCH { Adstw RTE

Fogh quakty  Racips data e St of images 7 Humber of wibcied mages § oM

Edit the images.
You can now edit the images displayed in the [Collection]
window.
Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

|
\\/

:@5 To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, clicking on
the image while holding down the <control> key, and selecting [Remove
from collection] from the menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by clicking while holding down the
<control> key, and selecting [Clear collection] from the menu that
appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

ﬁl You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after quitting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.92).
You cannot use the following functions in the [Collection] window.
« Starting of EOS Utility (p.7), or synchronizing of folders with

EOS Utility

» Batch change the file name of images (p.103)
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range

Introduction

Adjust the angle of the image as needed.
Trimming/angle adjustment window

= 111 IMCG_DO0T.CR2 (3456 % 2304]

—_—

Contents at

is only masked in black and the image will not be cropped. Largest a Glance
possible
Select the image to be trimmed. trimming Basic
range Operation
Open the trimming/angle adjustment window. Click
Click the [Trimming Angle] button. (rotate
— : : image left Ad%ed
Digital Photo Professional - [ MacOSX /Users/canon/Pic or rlght in Op ion
90-degree
(i:m:t Stamp TI"I:‘-‘I‘ITI!FI(_I I n Cre m entS) Advanced
check Angle Cancel ok Image Editing
""" \ - and Printing
Drag® (0.01-degree increments;
a adjustment range: -45 to +45 degrees) P .
rocessing
= . . Large Numbers
- - Use the mouse (click A/V) to adjust the angle or of Images
The trimming/angle adjustment window appears. directly enter the adjustment angle* (0.01-degree T —
Editing can be done once the image is displayed clearly in the increments; adjustable range: -45 to +45 degrees) Editing
trimming/angle adjustment window. * You cannot adjust the angle of images that exceed 9999 x 6666 JFI'EG/T'FF
. L mages
pixels in size.
If you click [Center on Screen], you can display the trimming
range in the center of the window. Reference
When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the
image. Index
If you click the [OK] button after adjusting only the angle of the

image, the image will be trimmed at the largest possible trimming
range.

|§| When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark lll,
EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M, the trimming range based
on the aspect ratio information is displayed.




Ciala) = 1/1 IMG_D001.CRE [1456 x 2304]

Select a ratio and drag the trimming range.

Cancel

Select a
trimming
ratio

Drag the
trimming
range

[ 4704, W62 E - 2302, 8410 ) = L 2577 8 4051 )1 350 )

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

1:1

3:2

2:3

4:3

3:4

5:4

4:5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Circle

[Free]: You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.

The trimming range frame is displayed in the trimmed image
(p.128).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.43).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.128).

+ Edit window: The image is displayed in its trimmed condition.

+ Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark IlI,
EOS 5D Mark lll, EOS 6D, EOS 7D, EOS 60D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M, the set trimming range
based on the aspect ratio information is displayed. Since the image is
not actually trimmed, you can change the trimming range or revert to
the condition before trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 60D, EOS REBEL
T4i/650D, EOS REBEL T3i/600D or EOS M, its trimming range
cannot be changed nor reverted to the condition before trimming,
since the image is actually timmed and saved in the set trimming
ratio.”

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.137).

* When shooting with EOS 5D Mark Il and [Add cropping information]
is set in Custom Functions, aspect ratio information is only set and
the image is not actually trimmed, even for JPEG images.

ALy

> Convenient functions of the trimming/angle adjustment
window

Ay

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <38 > key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <shift> key.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, see
p.137.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]

menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu » [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.98) can be saved as a separate file from the image
and loaded and applied to another image (p.99).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.56 to p.68) and the dust
erase processing explained in Chapter 3 (p.73 to p.77) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Open in Edit window ¥0
Open in Edit window (enlarged)

Liose l'!”

Lpen window 3N

Close window BW
Save H#S

Save As... {r3S

Add thumbnail to image and save {r3T

Convert and save... #D
Batch process... 3B

Create new folder... {r3EN

Page setup... 3P

Print... 3P

Print with detailed setting... 4 ¥D
Contact Sheet Prints... ~3EP

Plug-in printing [
Add to collection #O

Remave from collection 3G

Clear collection

Delete 3 <F
Info... #l

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Open in Edit window #0
Open in Edit window (enlarged)
Close all
Open window 3N
Close windo HEW
Save £
Save As... {r 385
' Convert and save... ®D l
Batch process... Ed
Create new folder... 13N
Page setup... {+ 3P
Print... P
Print with detailed setting... {+3%D
Contact Sheet Prints... ~ 3P
Plug-in printing 5
Add to collection *G
Remave from collection 138G
Clear collection
Delete <=
Info... £

The [Convert and save] window appears.

Specify the necessary settings, and then click the
[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

Convert and save

) }—— Enter a file name
%) }——— Select the save
destination

%) }——+— Select an image type
=

Image quality e e e

[Sa\te As: DPP_001

( Where: \__ Photo

File format

(Kind of file Exif-JPEG

Output setting

Output resolution 350 dpi  [) Embed ICC profile

Resize setting
] Resize
Width Height Unit
3504 x 2336 pixel
{ 3504 pixel ) {2336 pixel )
v Loc

—— Click and save

( Cancel ) Save

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

== To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

|§| By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.73 to p.77) actually
becomes a trimmed image or dust-erased image.
You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.91, p.92).

You can batch convert and save multiple images (p.101).
For a list of [Convert and save] window functions, see p.136.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

" Adjustment
Rotate left L
Rotate right 3R
Work color space >
Tone Curve Assist - 5tandard
Tone Curve Assist - High

Revert to last saved settings “_3Z
Revert to shot settings ~¥Z

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (this page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.46)
Printing Photographs with a Printer other than Canon Inkjet Printers
(p.49)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Introduction

Select the image to be printed. In the EPP EX window, select the [File] menu »
[Preferences].
Start up EPP EX. Contents at
Select the [File] menu » [Plug-in printing] » [Print with Easy- = 0 a Glance

PhotoPrint EX].

MNext Step Basic

Open in Edit window *O0 Operation
Open in Edit window (enlarged)
Close all
Oper wir dow N Preferences... Adv ed
Close window xW Op ion
Save ®S .
Save A s The [Preferences] window appears.
Add thumbnail to image and save (3T . . . . . . Advanced
AR 20 In [Print Quality], select [Quality Priority], click the Image Editing
Batch process... %8 [Option] button. In the dialog box that appears, and Printing
Create new folder... 138N checkmark [Print with the best quality when you
- . . Processin
Page setup... o 96P select [Quality Priority]]. Large Numbers
Print.. _ _ P Y, e 3 of Images
Print with detailed setting... {+3D R . > —_
Contact Sheet Prints... ~3EP |
g-in p g L wi = i Editing
Pri ith E -Ph Print EX umber of copies : > Copies
Add to collection £ UEWLT sy g :rinllng Orderp IB\;' Date =" 3 JT’EgéTeI:F
Remove from collection T #G Amount of extension of borderless printing :  Default :
Lleaczoliaction Print Quality [ Quality Priority 3)7— SeleCt
I[:_;:fte ::E Copon. ) Quality Reference
Priority
—
EPP EX starts up.
Index
e
( Defaults |
Help .‘_l l‘. Cancel ._l ( oK ) @ @
Click and checkmark [Print with the best quality @

when you select [Quality Priority]]



Select the [Advanced] tab, checkmark [Enable ICC
profile], and then click the [OK] button.
The [Preferences] window closes.

Specify the number of sheets to be printed, and then
click [Select Paper].

CIEEE) Pew Pt Print - Eavy -FrocoPrint £X
Seuacily B rusmioer of copees 1 e 1 nach image
Phots Print

fnrﬁ.mr

e ﬂ- = e o s
— il el O—===Click to
~ n = increasethe
-:‘::-E"E! e umberor
- sheets to be

h | printed

Select the paper type, and then click the [Layout/
Print] button.

ana Morw Photo Frint - Easy-FhotnPrint X
I o
G ]
- 2
o I R Select the
| | ¥ B paper size
— and type

[ Valp Il
it |

Click

Specify the layout, and then click the [Print] button.

ChEa) i P P e PR B
Sl o b o want B pric,
] Teview and ook e

Exif Print

L |

Select the
layout

I o B

e || P

Click to print
Printing begins.

J
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Introduction

"2 Additional information Printing Photographs with Canon Inkjet

Print up to 1000 images at a time Printers Compatible with Easy-PhotoPrint

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

Contents at
You can perform the following types of photograph printing with Canon a Glance

inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):

The printed image’s color is not what you expected Simple printing of RAW images

In the EPP EX window, select [Preferences] in the [File] menu and High quality printing using the color reproduction range of Adobe RGB o Bas't?

then click the [Advanced] tab in the [Preferences] window to display and a Canon inkjet printer peration

the [Advanced] tab sheet. L . .

In the [Advanced)] tab sheet, select [Enable ICC profile] in [Color Lc;eﬁe;();rgutrhfoﬂgjgg’\I/:/Ir?ezefseiizag téeflsr;tl:l’r;]?:)l:DIEiEFE\;?féﬁpit?bz A )
. L C : , : - - vice

Z:sqréelgt)lon for printing] and try printing using the [Perceptual setting inkjet printer, it is recommended that you print using Easy-PhotoPrint EX Opacion

(p.43). Note that since EPP is not compatible with Mac OS X 10.7,
printing is not possible with a computer running on Mac OS X 10.7.

. . o . . Advanced
|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.88). —_— |mag‘é Editing

Select the image to be printed. and Printing

Processing

Start up EPP‘ ) o ) . Large Numbers
Select the [File] menu » [Plug-in printing] » [Print with Easy- of Images
PhotoPrint].

Editing
Open in Edit window #0 ‘"TEGITIFF
Open in Edit window (enlarged) mages
Clase all
Open window 1M
Close windo HEW Reference
Save #ES
Save As... {r 365
Add thumbnail to image and save {3T
Convert and save... %D Index
Batch process... £
Create new folder... {r3EN ——
Page setup... {r3EP
Print... #*P
Print with detailed setting... %D
Contact Sheet Prints... ~3P
Plug D g Print with Easy-PhotoPrint  38E @

Add to collection #EGC
Remove from collection 3G

EPP starts up. 46



In the EPP window, select the [Easy-PhotoPrint]

menu » [Preferences].

Easy-PhotoPrint

About Easy-PhotoPrint...
Preferences... 3, )

Services [ ]

Hide Easy-PhotoPrint 3H
Hide Others C3H
Show All

Quit Easy-PhotoPrint  3Q

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

Preferences

“Print | Advanced |

Print Number of copies : 1 ’S Copies
|
Printing Order : ' By Date H’i
Amount of extension of . Default F‘#‘q
borderless printing :
Print Quality : [ . Quality Priority H’i]i
( Defaults
@ ( Cancel ) m

— Select
Quality
Priority

Select the [Advanced] tab sheet and check that the
EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color

reproduction.
Preferences
(Print | Advanced |
Image E ptimize images automatically

gApplv Rotate/Trimming to the same images in the same manner
When landscape images are rotated depending on the selected
® Rotate Left

) Rotate Right

Layout |1 Always trim when you select the layout with the margins

gSet margins to the minimum when you select the layout

with the margins

S Print filename when you select the index in layout

E Preview all layouts of A4 and Letter
Image | Select images from multiple folders
Selection

I Defaults |

@ ( Cancel ) 'HHI

If checked,
click to
remove the
check mark

Click to
close the
window

£ Specify the number of sheets to be printed, and then
click [Next].

Eﬁ@nmmm e

Click

Click to
increase the
number of
sheets to be
printed

J
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Check that the image compensation function is
disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

8068 Easy-Fhotofrint
=

Click

d Phato
ote Nolse Reduction |

Media Type .

Select the
paper type

yretar ot imagea <14 Pagae 31 - A P Type - Pty Pager Fra £ bl

8 Specify the layout, and then click [Print].

8na Eary-Fhotchint

Click to print

Select the layout

=» Printing begins.

2 Additional information

© Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

© The printed image’s color is not what you expected

Change the [Rendering intents when using Easy-PhotoPrint] (p.94) to
[Perceptual] (p.146) and print.

@ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.88).
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Select the image to be printed.

Select the [File] menu » [Print].

Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Open in Edit window HO
Open in Edit window (enlarged)

upen window N
Close window HW
Save H*S
Save As... {365
Add thumbnail to image and save {#T
Convert and save... ®D
Batch process... #B
Create new folder... 1+ 3N
Page setup... it 3P
Print... %P )
Print with detailed sefting... {4+ #ED
Contact Sheet Prints... ~¥HP
Plug-in printing b
Add to collection ®G
Remove from collection T ®G
Clear collection

Delete ® =
Info... |

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.

Printing begins.

Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image
Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

Open in Edit window #O
Open in Edit window (enlarged)

Close all

Qpen window 3N
Close window W
Save #S
Save As... {35
Add thumbnail to image and save 3T
Convert and save... HD
Batch process... 3B
Create new folder... {+3N
Page setup... 1+ 3P
Print... 3P
Print with detailed setting... G HD
Contact Sheet Prints... ~¥P
Plug-in printing >
Add to collection HG
Remove from collection {+#G
Clear collection

Delete 3@@]
Info... £ |

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.
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Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new
folder is to be created.

800 Digital Photo P|

11113,

Folder Collection(0)
v = MacOsx
» [A Applications

[7 Temporary ltems
v (& Users
v @ canon
» @ Desktop

» [ Documents
P [#@ Library

= Movies

[& Music

» [ shared

Select the [File] menu » [Create new folder].

Open in Edit window HO
Open in Edit window (enlarged)

Close all

Open window 3EN
Close window EW
Save #5
Save As... {r 385
Add thumbnail to image and save 8T
Convert and save... #D
Batch process... £

( Create new folder... {+ 3N ]

Page setup... {r 3P
Print... #*EP
Print with detailed setting... {+3#D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <option> key
and release when the image is in the destination

folder.
806 Digital Photo Profession
= (i E i
Folder Collection(0)
v =} MacOsx
» A Applications
[ Temporary Items
¥ | Users
¥ @ canon
¥ [ Desktop
L& Travel
» | Documents
» | & Library
s a0 .
& Music IMG_0001.CR2

¥ |2 Pictures
v [ photo
[ o0 _xx_xx
b [# Public
» [ Sites
» [3 shared

The images are moved or copied to the destination folder.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <option> key

and release when the folder is in the destination folder.

806 Digital Photo Profession

2 A E2)

Folder Collection(0)

¥ =l Macosx
» | A Applications
[ Temporary Items
¥ (¥ Users
¥ 1 canon
v [ Desktop

[ Travel
¥ |¥ Documents
> ¥ Library

S —

IMG_0001 CR2
4

P [ Sites
» [ shared

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be
registered.

8086 Digital Photo Profession

2 (6 Ez)

Folder Collection(0)
v =) MacOsx
» [A Applications
[ Temporary Items
¥ & Users
v 4 canon
¥ [@ Desktop
L2 Travel
» |3 Documents

L
» | ® Library

~ IMGOWLCRZ z

g Select

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Various preferences including advanced image adjustment, automatic
dust erasure processing, various printing functions for printing out work,
and color management are explained here, geared to the user who is
competent in the handling of third-party image editing software.

Adjusting While Comparing with the Original Image... 53
Changing How the Window is Split.............ccccoeeee 53

Adjusting by Comparing Multiple Images................. 54

Displaying an Area Beyond the Set Range as a

Warning Indicator (Highlight/Shadow Warning) ....... 95

Performing Advanced Editing............ccccoooovieiiinnnn, 56
Adjusting White Balance with Color Temperature ..... 56
Tuning White Balance with Color Wheel ................... 56
Adjusting Dynamic Range .............cccccveeeeeieeeenninnns o7
Adjusting Brightness of Shadows/Highlights ............. o7
Tone Curve Adjustment.............oooiiiiiee 58

Example of a Tone Curve Operation ..................... 29
Using a Picture Style File..........cccoooveiiiiiiiieeee. 59
About the RGB Tool Palette .............ccccceeeeiiiiinnen. 60

Using the Auto Lighting Optimizer...............c............ 61

Reducing NOISE........coooiiiiiiiiiiiii e 62

Correcting Lens Aberration ...........ccoooovvviiiiieeeennnnnnn. 63
Compatible Cameras..........ccccoeeeeiiiii 63
Compatible Lenses.......ccccoeeeeeiiiiiie 63
Making Corrections.............ceevveeeeeiiiiiiiieeeeee e 65

Effects of Distortion Aberration Correction for Fisheye

LENSES...ciiiieiieeeeeeeeeeee 66
About Shooting Distance Information Slider.............. 68
Correcting Multiple Images ata Time............cccccc...... 68

Using the Digital Lens Optimizer ............ccccccooeoee. 69
Compatible Cameras.............cccceeoeiiiiiiiieeeee, 69
Compatible Lenses...........ccccoeeeieiiiiiiiiii 69
Using the Digital Lens Optimizer..........ccccccoeeeieiiennnnn. 70

Performing Automatic Dust Erasure Processing ..... 73
Compatible Cameras............ccccccvviiieeeieeeeeeee e, 73
Automatic Dust Erasure Processing in the Main Window... 75

Manually Erasing Dust (Repair Function)................ 75
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION). .. 77

Transferring a RAW Image to Photoshop................ 78

Setting Work Color Space ...........ccoovvvvvvveiiiinciennnnn. 78

Compositing Images.........cccceevvieiiiiiieeeeecee e 78
Compositing Methods..............coooiiiiiiiiiieee e, 82

Creating HDR (High Dynamic Range) Images........ 82

Starting Up Map ULility ........cccooeveeiiiiiie 85

Printing with Shooting Information........................... 86

Printing a Thumbnail List (Contact Sheet Printing).. 87

Printing RAW Images on a High-End Canon Printer.. 88
Printing with a High-End Canon Inkjet Printer ............ 88

Printing with DPP and Easy-PhotoPrint Pro........... 88
Printing with DPP and Print Studio Pro .................. 89
Printing with a Large-Format Canon Printer............... 90

Specifying Preferences..........ccccoceevieieiiiiciiceeeeenn. 90
General Settings............oooeeiiii 91
View SettingS....coovviiiiiiiiieee e 92
TOOlI Palette .......oovveeiee e 93

Color Management...........cooooiiiiiiiiiiiiiieee e 94
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

In the edit window, select the [View] menu » [Before/

after comparison].

Glalal gl Pt Pl | Mt e e Pt Pl v W OO R T

[ e

The image divides into a left and right window.
The window on the right shows the image after editing.

Change the image display.

Select the [View] menu » [Change up/down/left/right] » [Up/

down].

|y v

The layout of the two images changes to top and bottom.
The bottom window shows the image after editing.

|§| Images can also be displayed in the edit image window by the same

operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu P [Display
mode] » [Split smgle |mage]

m—

=» One image is divided and displayed on the left and right or top
and bottom.

@ To switch between top and bottom, and left and right, perform the
same operation as step 2 on the left page.
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Adjusting by Comparing Multiple Images

Introduction

You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
T ] . : windows, the enlargement display position will also change in the Contents at
In the edit window, display the multiple images to be other edit windows. a Glance
compared. To cancel synchronization, select the [Window] menu »
Align the images. [Synchronize] again. Basic
Align the images for easy comparison. Operation

Select the [Window] menu » [Synchronize].

Advanced
Operation

Enlarge the image.
Enlarge and display any of the edit windows.

R R - TEEEED Advapced
S - % Imag iting
= A and Pfinting
<y | = Processing
o . E Al Large Numbers
i d o R of Images
h = “: T
s - s Editi
EEm——— e = S 1ting
' ' JPEGI/TIFF
Images
E o 4P Reference
o . . . Index
The other edit windows will also be displayed in the same
position/enlargement ratio. —
@ Synchronization only applies to the enlargement display position @

and the enlargement ratio. Adjustments to the images are not

synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning) _
Introduction
You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the . . . ..
image has exceeded that set range, you can display the highlighted part Select the [View] menu » [Highlight]. Similarly, select C:’gfanl:geat
in red and the shaded part in blue. [Shadow].
On the opened image, if there is an area that exceeds the value
Select the [Digital Photo Professional] menu » entered in step 3, the highlighted part of that area is displayed in Basic
[Preferences]. red and the shaded part is displayed in blue. Operation
Select the [View settings] tab sheet.
Advanced
. . . Operation
Enter the warning value for [Highlight] and [Shadow].

[ )
Preferences

Advanced
Ceneral settings | Wiew i | Tool palette Color management Imag |t|ng
and Pfinting
Grid pitch
64 Pixels(8-256)
. : Processing
Locking selected image La N b
Eﬂ Images opened in Edit window remain selected in main window rge umbers
S —— of Images
Magnification in Edit window
#) Fit to window O s0% O 100% O 200%
Magnification when the Edit/Edit image window is double-clicked JPEEdét/I¥|g|=F
@ s0% O 100% O 200% Images
RAW and JPEC
g Display only CR2 images for CR2 and JPEG files of the same name
Sort order in main window
™ Retain sort order Reference
Highlight/shadow warning
Highlight 255 | a9z-255 [N
Shadow 0 f (0-64) ]
Quick check tool display Index
® 50% () 100% (mairé reduction off)
f Cancel \ f 0K 3 @ @
Click the [OK] button to close the window.

|§| You can also display the warning with the same operation in the edit

image window.
55



Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/ALO] and [LENS]
tool palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

[ RaW | RGB NR/ALO  LENS |

‘Eﬂghtﬂess adjustment | |‘
---||------|m\?----||------ l:\'DD-
‘Whila balance adjustment [ 4 ;‘
|?| | 1 | 2 | 3 | Register... |
(' Color temperature s ]]’ Tune... \_I
= (seo0 k)——— Displays the value of the
setting

Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K increments).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

enn ‘White balance fine adjustment
Color tone: —— Enter the values
Color saturation: to set
Cancel DN - OK )
|
Drag

@ To register adjustment results as personal white balance (p.100),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You
cannot register the adjustment results as personal white balance
when you have selected [Shot settings] from the list box and have
done any tuning.

You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

|§| The adjustment range of color tone is 0 to 359 (1 increment in
numerical value input), and the adjustment range of color saturation
is 0 to 255 (1 increment in numerical value input).
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Introduction
Adjusting Dynamic Range Adjusting Brightness of Shadows/Highlights
Dynamic range (width of gradation expression) from dark points to bright You can adjust the brightness of shadows and highlights in an image. Contents at
points in an image can be adjusted. By adjusting shadows and highlights in an image with a restricted a Glance
brightness, you can reduce the effects of clipping in shadows and
_ highlights.
|P|r_lure Styla [ 5 !| Basic
i = ‘—\' Move downwards Operation
Ps‘a’“’“’d 1+ B’_““‘;""' - Output highlight points [Pt st =]
' Standard 10 Browse.. ) Ad d
. vance
Move tp th_e left or right v — 4 Operation
Input highlight points i /
H-ID_U a2 n F a0 = o o 3 0 0 .:
; Advapced
Contrast: {11 | —— _ 3 e 1 Imag‘aﬁting
Highlight: {3 e—— 100 -80 60 -40 -20 0 20 40 and Pfinting
Shadow: (1] m Contrast:
" Linear Move upwards Highlight: Drag the sliders left or Processin
IR . e Output shadow points Shadow: Tright Large Numbtgrs
Color saturation: (T — ) Linear of Images
_ Unsharp mask 4] Colar tone: [y Fp——
Strength: {0 R Color saturation: (] STy — Editing
Fineness: (7 B —— . Unsharp mask I+ JPEGI/TIFF
Threshold: e ey Strangth: oo Images
Move to the left or right ::::d ig; @_
Input shadow points o Reference
The horizontal axis shows the input level and the vertical axis
shows the output level.
Index

00
©
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.145).

In the tool palette, select the [RGB] tab sheet.

Select the tone curve mode and interpolation

method.
| RAW | RGB | NR/ALD = LENS |
|Tcme Curve assist + | [P ‘
Tone curve adjustment | i ‘
RGB R|lc]s E
- o - = E -
255 /}
/
P
A
/
g
v Clurve
Straight
v RGBRGB
Luminance RG B
//
it
R
ol
— e
o 255
: —————— - A
B”ghtnESS: ----u.:::;\.': [RRNREN] D W
Contrast: " 1—_? 0 :
—_— H A0
Hue: - R E
Saturation: ”__(.-3“ o ko) D100t
Sharpness: Elr—':g ol

<control> + click inside
the graph to display the
menu

Make adjustments.
Batch adjusts RGB

Adjusts each channel
4 RAW | RGH MNR{ALO LENS | -
|Tcme clrve assist Ol Ps ‘
Tone cprve adjustment = ‘
RGB IRlEG.i!EJ 1]
[ 255] L
V4
i/’
f/f
f/’
I/’
f/f
rd . .
' o Click to add a [[1] (point)
| A Adjust by dragging [[]
T
g
_
- «.”; = s
0 255
Brightness: -—‘3—' _D 7
Cantrast: R Y B
-ﬁ ’—- el .-
Hue: 9 o ¥
Saturation: { 3 b " 100 i
Sharpness: F_/Ir—' +H 0 ':'

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[]] is 8.

To delete a [[]], double-click on the [[].

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.93).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.93).
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f C O Introduction
Example of a Tone Curve Operation - . :
P _ _ P _ Using a Picture Style File
Makes medium tones brighter Makes medium tones darker
A Picture Style file is an extended function file of a Picture Style. Contents at
; / With DPP, you can apply to RAW images Picture Style files that you a Glance
7 ¥ have downloaded from Canon Web site effective for various scenes or
// s Picture Style files created with “Picture Style Editor”. When using a
/ §d Picture Style file, save it to your computer beforehand. Basic
// 4 Operation
o s . . . . _
/ ot Display the image to which the Picture Style file is to
/ 4 be applied in the edit window (p.11). Advanced
. Operation
/4 Select the [RAW] tab sheet in the tool palette, and
vis 7 j click the [Browse] button.
/ Advapced
‘Picture Style ) ‘ |mag iting
and Pfintin
Makes tones harder Makes tones softer Ny ! Processing
Large Numbers
/ of Images
.// /
s ¢ ; - n Editing
/ A =10.0: =80 -6.0 -4.0 =210 0 20 4.0 JPEG/TIFF
s g I
/x'f // The [Open] dialog box appears. R
- . .
e Select a Picture Style file saved on your computer,
4 .
s ik and click the [Open] button. elsienes
o //' The Picture Style file you selected is applied to an image.
M ) To apply a different Picture Style file, follow the procedure from
£ step 2 again. Index

ﬁl The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only. Furthermore, you cannot apply
Picture Style files with the extension “.PSE” to an image; however if
such a file is registered in the camera and the image is shot, the

image will display correctly. 59



About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.58) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
See Chapter 5 for explanations on functions of the [RGB] tool palette
other than tone curve adjustment.

E\@/E Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/ALO] and [LENS] tool palette
(p-131) when applying the Auto Lighting Optimizer (p.61), reducing
noise (p.62) or correcting aberration (p.63) after you have made any
required adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more pleasant image.

You can also change the settings of the image shot with the camera’s

Introduction

Checkmark the checkbox.

! RAW RGB MR/ALO LENS |

‘Auw Lighting Optimizer Contents at

Auto Lighting Optimizer function. @ Checkmark aGlance

This function is compatible only with RAW images shot with EOS-1D X, e e SHog

EOS-1D Mark IV, EOS 5D Mark Ill, EOS 5D Mark Il, EOS 6D, EOS 7D, Basic

EOS 60D, EOS 50D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, For images shot with the camera’s Auto Lighting Optimizer Operation

EOS REBEL T2i/550D, EOS REBEL T1i/500D, EOS REBEL T3/1100D function, the checkbox is already checked.

and EOS M.

* ALO stands for Auto Lighting Optimizer. Change the settings according to your preferences. é“"a"{?ed
peration

! RAW RGB MR/ALO LENS |

Select the [NR/ALO] tab sheet from the tool palette in

‘Auw Lighting Optimizer ‘

the edit window or edit image window. v Ad\atjzed
— - ; : ' . Ima itin
_ h .RA'-; . F,EGB | neyaro ] LEns | Low Standard St;:ng Ej\i\?/gt;rr?g:g;gﬁgiéels an(? ntingg
uto Lighting Optimizer
| | Auto correction is applied to the image to match the settings. P .
T — G — i i , o o rocessing
A0 Stan\;ard b For images shot with the camera’s Auto Lighting Optimizer Large Numbers
= _ i function, the settings at the time of shooting are applied as the of Images
[P ety | default values.
RAW MR Peoview.. J To cancel the Auto Lighting Optimizer, remove the check mark J;gg;?ﬁ:F
Luminance noise reduction from the checkbox. Images
[21 D ITFrrrrier e e 20
Chrominance noise reduction
(3) (H] 20
Reference
TIFF/JPEG
Luminance noise reduction
0 L 20
Chrominance noise rer_lucl_i?n Index
) o 20
Lens aberration correction  Tune.. |
(D) © When [Highlight tone priority] is set to [Enable] in EOS-1D X, EOS
T i 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS REBEL T4i/650D, @ @
b . EOS REBEL T3i/600D, EOS REBEL T2i/550D, EOS REBEL T3/
i bl i 1100D and EOS M, the Auto Lighting Optimizer function cannot
A be set.
Distorticn OFF
You cannot use the Auto Lighting Optimizer with multiple-

exposure RAW images created on the camera.
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.
|Noise reduction

RAW [[ NP Preview... |

The [NR Preview] window appears.

Adjust an image.

800 NR Preview

Navigator
window

— Enlargement
display
position

Luminance noise reducty
{0

e = Drag the
P sliders

P Y —

Chrominance noise redygai
(v}

3 Cancel

NR check| window
You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.
The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.
You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

? The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.91) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

VL
-~ To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.131) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

i

You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.93).

* When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high 1ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise] has been set, resolution may be reduced

along with reduction of noise.

If [Chrominance noise] has been set, color bleeding may occur

along with reduction of noise.

For a list of [NR Preview] window functions, see p.133.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Il
EOS-1D Mark Il EOS-1D Mark II N EOS-1Ds Mark Il
EOS-1D Mark I EOS-1Ds EOS-1D

EOS 5D Mark Il EOS 5D Mark Il EOS 5D*1

EOS 6D EOS 7D EOS 60D

EOS 50D EOS 40D EOS 30D*2

EOS REBEL T4i/650D EOS REBEL T3i/600D EOS REBEL T2i/550D

EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL
T1i/500D XSi/450D XTi/400D DIGITAL
EOS REBEL EOS DIGITAL REBEL EOS M

T3/1100D XS/1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Fisheye, ultra wide, and wide angle lenses
EF 14mm f/2.8L USM EF 14mm f/2.8L Il USM*3
EF 8-15mm f/4L USM Fisheye*3 EF 15mm /2.8 Fisheye*3
EF 20mm /2.8 USM EF 24mm f/1.4L USM
EF 24mm f/1.4L Il USM*3 EF 24mm /2.8
EF 24mm /2.8 IS USM*3 EF 28mm /1.8 USM
EF 28mm /2.8 EF 28mm /2.8 IS USM*3
EF 35mm f/1.4L USM EF 35mm f/2

Standard and medium telephoto lenses

EF 40mm f/2.8 STM*3
EF 50mm f/1.4 USM

EF 50mm /1.8 1l

EF 85mm f/1.2L Il USM*>
EF 100mm f/2 USM

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 86mm /1.8 USM

Telephoto lenses

EF 135mm /2L USM

EF 200mm f/2L IS USM*3
EF 200mm f/2.8L Il USM
EF 300mm f/2.8L IS USM
EF 400mm f/2.8L IS USM
EF 400mm /5.6L USM

EF 500mm /4L IS USM

EF 600mm /4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm f/2.8L USM

EF 300mm f/2.8L IS Il USM*3
EF 300mm /4L IS USM

EF 400mm f/2.8L IS Il USM*3
EF 400mm /4 DO IS USM
EF 500mm f/4L IS Il USM*3
EF 600mm f/4L IS Il USM*3
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Zoom lenses

EF 16-35mm f/2.8L Il USM*3

EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-70mm f/4L IS USM*3

EF 24-105mm f/4L IS USM

EF 28-90mm f/4-5.6 USM

EF 28-90mm f/4-5.6

EF 28-90mm f/4-5.6 Il

EF 28-105mm f/3.5-4.5 1| USM
EF 28-105mm f/4-5.6

EF 28-200mm /3.5-5.6

EF 28-300mm /3.5-5.6L IS USM
EF 55-200mm f/4-5.6 USM

EF 70-200mm f/2.8L IS USM

EF 70-200mm f/4L USM

EF 70-300mm f/4-5.6L IS USM*3
EF 70-300mm f/4.5-5.6 DO IS USM
EF 75-300mm f/4-5.6 11I*3

EF 75-300mm f/4-5.6 [l USM

EF 90-300mm f/4.5-5.6

EF 100-300mm f/4.5-5.6 USM

EF 16-35mm f/2.8L USM

EF 17-35mm f/2.8L USM

EF 20-35mm /3.5-4.5 USM

EF 24-70mm f/2.8L Il USM*3
EF 24-85mm /3.5-4.5 USM

EF 28-70mm f/2.8L USM

EF 28-90mm f/4-5.6 Il USM

EF 28-90mm f/4-5.6 I

EF 28-105mm /3.5-4.5 USM
EF 28-105mm /4-5.6 USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm /3.5-5.6 USM
EF 55-200mm /4.5-5.6 1| USM
EF 70-200mm f/2.8L USM

EF 70-200mm f/2.8L IS 1l USM*3
EF 70-200mm f/4L IS USM*4
EF 70-300mm /4-5.6 IS USM
EF 75-300mm f/4-5.6 11*3

EF 75-300mm f/4-5.6 USM

EF 75-300mm /4-5.6 IIl USM
EF 90-300mm /4.5-5.6 USM
EF 100-400mm /4.5-5.6L IS USM

Macro lenses
EF 50mm f/2.5 Compact Macro*3 EF 100mm f/2.8 Macro USM
EF 100mm /2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo*3

5

EF-S lenses
EF-S 60mm /2.8 Macro USM EF-S 10-22mm f/3.5-4.5 USM
EF-S 15-85mm /3.5-5.6 IS USM*3 EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 IS USM  EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm /3.5-5.6 1| EF-S 18-55mm f/3.5-5.6 I11*3
EF-S 18-55mm f/3.5-5.6 USM EF-S 18-55mm f/3.5-5.6 Il USM
EF-S 18-55mm f/3.5-5.6 IS*3 EF-S 18-55mm f/3.5-5.6 IS 11*3
EF-S 18-135mm /3.5-5.6 1S*3 EF-S 18-135mm f/3.5-5.6 IS STM*3
EF-S 18-200mm /3.5-5.6 1S*3 EF-S 55-250mm f/4-5.6 1S*3
EF-S 55-250mm /4-5.6 IS II*3

EF-M lenses

EF-M 22mm f/2 STM EF-M 18-55mm /3.5-5.6 IS STM

Aberration correction will not apply to images shot with a combination
of lenses *3 *4*5 and EOS 5D or EOS 30D with the firmware versions
below.

* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EQOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*5 EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.

The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.
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Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions

In the tool palette, select the [LENS] tab sheet.

Click the [Tune] button.

- RAW RGEB NR/ALO LENS |

|DEgil,aI Lens Optimizer r——

Setting OFF
Lens data No
1 Upc_iate...

Lens aberration correction [ ——— ]|
Peripheral illumination OFF
Chromatic aberratian OFF
Caolor biur QOFF
Distortion QFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

ns aberration correction - [IMG_0001.CR2]

. peripheral iiumination
o
__ Chromatic aberration
Re—(— E— (]
[ Color blur
[ Distortion

oK

— A o

The image is corrected and redisplayed.

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.138).

You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF 8-15mm f/4L USM Fisheye or EF 15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Aberration Correction for Fisheye Lenses” (p.66).
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Introduction
For images shot with EF 8-15mm /4L USM Fisheye, a fine-tune Effects of Distortion Aberration Correction for
slider is also displayed when you select [Emphasize Linearity] .
from the [Effect] list box. FISheye Lenses
Adjust the amount of correction for distortion aberration with the Shot settings C:r(l;tfanl:geat
adjustment slider, and then adjust with the fine-tune slider if more By selecting this option, only distortion aberration correction for
adjustment is required. o correcting optical distortion is performed.
When the list box for selecting an extender is displayed, select Basi
the extender attached at the time of shooting from the list box. Opearzlt?on
Click the [OK] button.
The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the gd‘g_‘;‘t‘i’gg
image is redisplayed. P

The result of the settings of the [Lens aberration correction]

window is also displayed in the tool palette. Advanced
In the main window, the [ g}¥ ] mark is displayed on the image to Imag‘gii_ting
indicate the lens aberration corrections (p.128). and Pfinting
Processing
Emphasize Linearity Large Numbers
of Images

This converts the image to a “central projection” style image. This
projection method is used with general lenses. =
Differing from fisheye lenses, central projection displays straight lines Editing

. . . . . . . : JPEG/TIFF
as straight lines. By selecting this option, a wide-view panoramic Images
image can be obtained. However, the periphery is stretched, resulting
in decreased resolution.

' Reference
& z
< |

Index

.
,. 00
PVARN
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Emphasize Distance

This converts the image to an “equidistant projection" style image.
This projection method preserves distance relationships.

Equidistant projection displays the same distances from the center to
the periphery as the same distances. In particular, when shooting a
celestial body such as the celestial sphere, any height above the
horizon (declination) is captured at an equal interval. This method is
therefore used in such photography as celestial photography (star
maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correcily. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.

Emphasize Center

This converts the image to an “orthogonal projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

® While selecting any of the options [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center] will yield results similar to each of the projection methods,
the conversion does not exactly apply each projection method in
their precise sense.
Accordingly, care should be taken since they are not suited to
scientific or other such purposes.
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

The distance cannot be minutely adjusted by using the slider forimages
shot with an EF-M lens. (The slider is not displayed.)

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Il

EOS-1D Mark Il EOS 5D Mark llI EOS 5D Mark Il

EOS 6D EOS 7D EOS 60D

EOS 50D EOS 40D EOS REBEL
T4i/650D

EOS REBEL EOS REBEL EOS REBEL

T3i/600D T2i/550D T1i/500D

EOS DIGITAL REBEL EOS REBEL EOS DIGITAL REBEL

XSi/450D T3/1100D XS/1000D

EOS M — —

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS DIGITAL REBEL

XTi/400D DIGITAL

For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool palette] button (p.126) in the toolbar. If you

perform correction procedures (p.65) when tool palette is displayed, you

can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise

reduction of the noise reduction function (p.62). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.31).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.29) and/or the color saturation (p.109) to
make the color deeper.

The result of [Color blur] correction cannot be detected

[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]
correction is made.

@ For a list of the [Lens aberration correction] window functions, see
p.138.
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Using the Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena
that are unavoidable as long as light must pass through the lens. These
optical phenomena cannot be corrected under [Lens aberration
correction] (p.63). Correction is achieved using the designed value of
each lens. The images that can be corrected are RAW images shot
using any of the following “compatible cameras” and “compatible
lenses”. JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected.
To use this function, [Lens data] for the lens used to shoot images first
needs to be downloaded to your computer.

Before using the Digital Lens Optimizer, it is recommended that you set
[Sharpness] or [Strength] for [Unsharp mask] for images to 0.

Compatible Cameras

Compatible Lenses

Wide angle lenses

EF 14mm f/2.8L USM
EF 20mm /2.8 USM
EF 24mm f/1.4L USM
EF 28mm /1.8 USM
EF 35mm f/1.4L USM

EF 14mm f/2.8L Il USM
EF 24mm f/1.4L Il USM
EF 24mm /2.8 IS USM
EF 28mm /2.8 IS USM

Standard and medium telephoto lenses
EF 40mm /2.8 STM EF 50mm f/1.4 USM
EF 50mm f/1.2L USM EF 85mm f/1.2L USM
EF 85mm f/1.2L [l USM —

Telephoto lenses
EF 300mm f/2.8L IS Il USM EF 400mm f/2.8L IS Il USM
EF 500mm f/4L IS 1l USM EF 600mm f/4L IS Il USM

Zoom lenses
EF 16-35mm f/2.8L Il USM
EF 24-70mm f/2.8L USM
EF 24-70mm f/4L IS USM

EF 16-35mm f/2.8L USM
EF 17-40mm /4L USM
EF 24-70mm f/2.8L Il USM

EF 24-105mm f/4L IS USM
EF 28-200mm /3.5-5.6 USM
EF 70-200mm f/2.8L IS USM

EF 28-70mm f/2.8L USM
EF 28-300mm /3.5-5.6L IS USM
EF 70-200mm /2.8L IS Il USM

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Il
EOS-1D Mark Il EOS-1D Mark II N EOS-1Ds Mark I
EOS-1D Mark Il EOS-1Ds EOS-1D

EOS 5D Mark Il EOS 5D Mark I EOS 5D*1

EOS 6D EOS 7D EOS 60D

EOS 50D EOS 40D EOS 30D*?

EOS REBEL EOS REBEL EOS REBEL
T4i/650D T3i/600D T2i/550D

EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL
T1i/500D XSi/450D XTi/400D DIGITAL
EOS REBEL EOS DIGITAL REBEL EOS M

T3/1100D XS/1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

EF 70-200mm f/4L USM EF 70-200mm f/4L IS USM

EF 70-300mm f/4-5.6L IS USM  EF 100-400mm f/4.5-5.6L IS USM
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Macro lenses
EF 100mm f/2.8L Macro IS USM —_

EF-S lenses
EF-S 10-22mm 1/3.5-4.5 USM EF-S 15-85mm f/3.5-5.6 IS USM
EF-S 17-55mm /2.8 IS USM EF-S 17-85mm f/4-5.6 IS USM
EF-S 18-135mm f/3.5-5.6 IS EF-S 18-135mm f/3.5-5.6 IS STM
EF-S 18-200mm f/3.5-5.6 IS —

EF-M lenses

EF-M 22mm f/2 STM EF-M 18-55mm 1/3.5-5.6 IS STM

The Digital Lens Optimizer is also available for images shot with
an extender mounted on a compatible lens.

You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.

Using the Digital Lens Optimizer

In the tool palette, select the [LENS] tab sheet, and
check the status of [Lens data] for [Digital Lens
Optimizer].

- RAW RCB NRSALO LENS ]
Tuge... | |

Setting OFF

|Digila| Lens Optimizer

Lens data Mo
( )

Update...

|Lens aberration carrection [ Tune.. |
[Not Available] is displayed for an image shot with a non-
compatible camera or lens, or for a non-compatible image such
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images.

If [No] is displayed, proceed to step 2. To use the function, you
need to download [Lens data] for the lens used when shooting
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked
using the [Info] button in the toolbar on the main window (p.23).
If [Yes] is displayed, proceed to step 4 on the next page.

|§| Before you click the [Update] button in step 2, Lens data [No] may

be displayed instead of [Not Available] for non-compatible images.
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Click the [Update] button.

b | RAW RGB  NR/ALO | LENS }——
|DEgil,aJ Lens Optimizer Tune... |
Setting OFF
Lens data No
T

Checkmark the checkbox for the lens used to shoot
the image, and click the [Start] button.

Add or Remove lens data

" EF500mm FAL IS Il USM
EF600mm F4L IS Il USM
EF16-35mm F2.8L Il USM
EF16-35mm F2.8L USM
EF17-40mm F4L USM i
EF24-70mm F2.8L Il USM
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EF24-70mm F2.8L USM
EF24-105mm F4L IS USM
EF28-300mm F3.5-5.6L IS USM
EF70-200mm F2.8L 1S 1l USM Advanced

EF70-200mm E2.8L IS USM Operatlon

|Lens aberration correction |

The [Add or Remove lens data] window appears.

£ EF70-200mm F4L USM (Add)
T F3-5.0L 15 UM

Imag\gﬂtmg
and Pfinting
. Processing

The lens data is downloaded to your computer. Large Numbers

=» When the downloading of the lens data ends, the indication for of Images
[Lens data] changes to [Yes].

© You can download the data for up to 30 lenses at the same time. Jlfgg;?ﬁ:F
If you remove the check mark from the checkbox for already- Images

downloaded lens names and click the [Start] button, the lensdata
will be deleted from your computer.

Reference
® Depending on the type, current state, etc. of software running on -
your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again. -
naex

@ To use this function, an environment with Internet access @
(subscription to a provider, browser software installed and an in-
place line connection) is required.

An administrator-level privilege is required for this operation. 71



4

Click the [Tune] button.

| RAW RGB NR/ALO | LENS } |
|Eiglla! Lens Optimizer ( [ Tune.. ])
Setting. 50

=»The [Digital Lens Optimizer] window appears.

Checkmark the [Setting] checkbox and adjust the
image.

faNo.

& =20
= e paee
re =

@ @ The [Setting] checkbox will be checkmarked if the image has the
Digital Lens Optimizer already applied. Remove the checkmark
and click the [Save] button to cancel the Digital Lens Optimizer.

© Images displayed in the [Digital Lens Optimizer] window are with
[Sharpness] and [Unsharp mask] effects applied by default. If you
checkmark the [Do not sharpen previews] checkbox, images are
displayed without [Sharpness] or [Unsharp mask] effects applied,
allowing you to check only the Digital Lens Optimizer effect.

© When applying the Digital Lens Optimizer, the effect of
[Sharpness] or [Unsharp mask] may become excessive. It is
recommended that you set [Sharpness] or [Strength] for [Unsharp
mask] for images to 0 before using the Digital Lens Optimizer.
Adjust [Sharpness] or [Unsharp mask] again after applying the
Digital Lens Optimizer to images.
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Performing Automatic Dust Erasure Processing= |
When the list box for Se|ecting an extender is disp|ayed, select The Dust Delete Data that is appended to images shot with the camera
the extender attached at the time of shooting from the list box. that can attach this data, can be used to automatically erase dust spots.
Use the slider to adjust the Digital Lens Optimizer effect. Contents at
When [MAX] is displayed for the Digital Lens Optimizer level, the . a Glance
effect will remain the same even if you move the slider further to Com patible Cameras
the right.
You can change the display position of the check window by Basic
dragging the enlargement display position in the navigator EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Il Operation
window. o o EOS-1D Mark Il| EOS 5D Mark Ill EOS 5D Mark i
Even if you set shooting distance for a lens in this window, the
value indicated for shooting distance in the [Lens aberration EOS 6D EOS 7D EOS 60D Advanced
correction] window will not change. EOS 50D EOS 40D EOS REBEL Operation
If no shooting distance information is saved to the image, the T4i/650D
shooting distance slider is set automatically to the right end at
infinity position and a [<!>] appears above the shooting distance EQS REBEL EO_S REBEL EO.S REBEL Imp;;‘g‘jiet?ng
slider. The distance cannot be minutely adjusted by using the T3i/600D T2i/550D T1i/500D and Pfinting
slider for images shot with an EF-M lens. (The slider is not EOS DIGITAL REBEL EOS DIGITAL REBEL EOS REBEL
displayed.) XSi/450D XTi/400D DIGITAL ~ T3/1100D Processing
Images cannot be corrected for [Chromatic aberration] in [Lens Large Numbers
aberration correction] if the Digital Lens Optimizer has been EOS DIGITAL REBEL EOS M - of Images
applied. XS/1000D
Click the [Save] button. In the main window, select an image appended with JIES(I;II!I']IQFF
\ Dust Delete Data. Images
Click the [Stamp] button.
= - g Reference
Digital Photo Professional - [ MacOSX /Users/canon/Pic
The [Digital Lens Optimizer] window closes and correction 4 \3 @ \@ & \a
results are applied to the image in the edit window. e et Rowterigh —Ouick— — Stmp :?;;mg fatc

Corrections made in the [Digital Lens Optimizer] window are also e ; ”,'glg, = F, Index
displayed in the tool palette.

In the main window, the [%] mark is displayed on the image to

indicate that the Digital Lens Optimizer is applied (p.128).

After clicking the [Save] button, the application of the corrections @ @

to the image may take some time. The copy stamp window appears.
The size of the image file will be larger after applying the Digital

Lens Optimizer.
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When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

[ana 173 NG040 CZ (1454 = 3504

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [@,] mark (p.128) is displayed on an image from which dust
spots have been erased.

? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

@ The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.75) or the copy stamp function (p.77).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).
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AL/

-@> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.142.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.

Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

right nun:& Sramp Tnﬂrr ing
check Angle

=» The copy stamp window appears.

When the image has redrawn itself, double-click the
pomt from where dust is to be erased.

12 A DO%0.CH2 (1456w 5041

1000 vem 1 Fusture v |

[ Aol Duir Delete s |5
g [

The display changes to 100% view.
The display position can be changed by dragging.
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Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [ @»( ) |] button, and if
the dust spot is light in color, click the [ ¢ »( 3] button.
When you move the cursor over the image, the dust erasure
range appears as [Q].

Place the dust spot to be erased within the [O] and
click.

o 7L MC_DOD.CRE (1456 = 004]

© =1 Click

=

E==rrrress === =) e Carer
e b ot v 1 -

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [8,] mark (p.128) is displayed on an image from which dust
spots have been erased.

? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.77).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).
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AL/

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <3B8> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, see p.142.

Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.75).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [@,] mark (p.128) is displayed on a corrected image.
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Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, see p.102.

|§| Compatible versions of Photoshop are CS or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.145) is added. The ICC profile
contains information about [Preferences] (p.94) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.
When you quit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred

image as a separate image in Photoshop is highly recommended.

For CS4 or later versions of Photoshop, this function is not
available if a 32-bit version is not installed.

Setting Work Color Space

A different work color space (p.146) from the default settings (p.94) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.94), this default
setting will not be applied and the individually set color space will remain.

-:\@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.

Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.

The color space of a composited image will be the color space of
the background image.

Image information is not appended to a composited image.

Select a background image in the main window.

Adin 8CH | debom ¥CB gy —-

You can also select a background image from the edit window,
edit image window, or [Collection] window.
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Select the [Tools] menu P [Start Compositing Tool].

Start Quick check tool
Start Stamp tool

t Trimmina/Angle Adjustment tool
Start Compositing Tool

Start HDR Tool

Start Rename tool

Start EOS Utility

Sync folder with EOS Ut

Transfer to Photoshop

HEF
W
NET

X

Y
NHR
NHE

NP

The compositing tool window appears.

B o

{ 100% view i

nd |

| Select an Imlge

Select the image to combine.
Select the image to combine from the [Foreground Image] list
box.

100% view

Select an image
¥ IMG_0001.CR2
IMG_0002.CR2
IMG_0004.CR2
IMG_0006.CR2

=» The selected image is displayed in the [Foreground Image]
thumbnail display.

=» A preview of the combined background image and foreground
image is displayed in the composite preview.

©® The following images can be combined.

* When a background image is selected in the main window
([Folder] window) or edit window: image in same folder as
background image

* When a background image is selected in the [Collection]
window: image in the [Collection] window

* When a background image is selected in the edit image
window: image displayed in the thumbnail display area

You can combine images of differing sizes.
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Select a compositing method.
Select a compositing method from the [Composite Method] list
box.

| IMC

¥ Add

Average
Weighted
Lighten
Darken

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.82).

If you select [Weighted], you can set the proportion of brightness
of the image to be combined. Use the [Weight] slider at the
bottom of the [Composite Method] list box or directly enter a
value to set the brightness proportionally.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Position the images.

L Yala || IMG_0001.CR2 [3456 x 2304]

Shift large amount (50 pixels)
Shift small amount (1 pixel)
Align image centers

You can also directly enter the position

coordinates of the [Foreground Image]
to align it.

By default, the background image and the [Foreground Image] are
displayed with their centers aligned.

[Compose in RAW Format]

Checkmark the [Compose in RAW Format] checkbox as necessary.

@ You can set [Compose in RAW Format] under the following @
conditions.
Both the background image and [Foreground Image] are RAW
images, and, all the following conditions are met.
» The cameras used to shoot were of the same model
» The ISO speed setting at time of shooting was the same
* The highlight tone priority setting at time of shooting was the same
» The image sizes (original size) are the same

The following functions are not available for images composited
with [Compose in RAW Format].

* Auto Lighting Optimizer (p.61)

* Picture Style Auto (automatically set to Standard) (p.59)

+ Selecting [Circle] for the aspect ratio when trimming (p.39)
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Click the [Save As] button.

Position

ES
—
-~

SB00

v

—

53
9

\) WD

X 0 [

Y o

Continue

Save As...

oY

Close }

By clicking the [Save As] button, the [Convert and save] window
(p-42) appears. Specify the required settings, and then click the
[Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The brightnesses of the background image and [Foreground Image]
are added and images are overlaid.

Average

Images are overlaid with negative exposure compensation being
applied automatically. If you want to change the amount of exposure
for individual images, select [Weighted].

Weighted

Compositing method where brightness is set proportionally for the
[Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions being combined.

Darken

The background image and the [Foreground Image] are compared,
with only darker portions being combined.

Creating HDR (High Dynamic Range) Images
You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures of the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.
Image information is not appended to an HDR image.

Select an image in the main window.

Dvgetal Pvoos Pristessicnal - | LW, Lsary Canon Foctir s Fhota acs_xs n |
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2 Select the [Tools] menu » [Start HDR Tool].

Start Quick check tool LEF
Start Stamp tool NS
Start Trimming/Angle Adjustment tool X #T
iting Tool X
Start HDR Tool XY
Start Rename tool R
Start EOS Utility NHE
Sync folder with EOS Utility
Transfer to Photoshop N &P

=» The [Select Images] window appears.
@ You can also display the [Select Images] window from the edit

window and edit image window.

Specify the required settings, then click the [Start
HDR] button.

Seactliages

IMG_0001.CR2 IMG_0002.CR2 IMG_0003.CR2

Browse... 2 Browse... | Browse... ;

St OR

@ To change the selected image, or add another image, click the
[Browse] button and in the [Open] dialog box that appears, select
the image file and click the [Open] button.

® If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

=» By clicking the [Start HDR] button, the [Adjust Image] window
appears.

® After using auto image alignment, the periphery of the images is
partially deleted.

)
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Make required selections to adjust the image.

anm Adjust Image

Presets.
| Natural v
Tone/Color
Brightnessi(55)
O
Saturation:(50)

Save As...

Sliders in [Adjust Image]
[Tone/Color]

[Brightness]: Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.

[Saturation]: Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

[Contrast]: Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]

[Strength]:

Adjusts the overall contrast and contrast of

details together. Move the slider to the right for a

stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.

[Fineness]:

Move the slider to the right for a smooth and
natural impression.

Adjusts the clearness of details. Move the slider

to the right for a sharper outline.

[Presets] and finishing effects
With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by

default), instead of operating the sliders individually. By selecting
a finishing effect, each slider moves according to the setting. You

can also operate and adjust the sliders after selecting an effect.

[Natural]:

[Art standard]:

[Art vivid]:
[Art bold]:

[Art embossed]:

In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

Gives a finish with painting-like tonality for an
impressive image.

For a more vivid look than with [Art standard].
For a more vivid look than with [Art standard],
that makes the subject pop out.

Tones down sharpness more than [Art standard],
for an old-fashioned feel.
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Click the [Save As] button.
e ]

: By clicking the [Save As] button, the [Conert and save] (p.42)
window appears. Specify the required settings and click the
[Save] button.

Starting Up Map Utility

Map Utility is a software that allows you to view images shot on a GPS
function-compatible Canon camera, including the shooting location and
route travelled. After installing Map Utility to your computer, you can
start it up from DPP.

Select the [Tools] menu P [Start Map Utility].
Map Ultility starts up.
For information about Map Ulility, refer to the Map Utility
instructions, or to the Help for Map Utility.

® Do not edit images with DPP and use Map Utility at the same time.
Editing results may not be saved properly.

|§| > Version 1.1.0 or later versions of Map Utility are compatible.
® Map Utility is not included on the EOS DIGITAL Solution Disk.

© [Start Map Utility] will not appear in the [Tools] menu if Map Utility
is not installed to your computer.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

# IMG_0001.CR2

({ Printer | Image Text Settings )

Printer :

Media
Ad

Media orientation

~ 7
\_J Portrait

® Landscape

Media size:
297.0 mm x 209.9 mm
Print profile:

CMYK profile:

oo X _cme e )

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

A/
~

== To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.94).
If CMYK simulation has been set, the image is printed in the set
colors (p.94).
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.
Select the [File] menu » [Contact Sheet Prints].

Specify the required settings for printing, and then
click the [Print] button.
Switches the settings tab sheet

Contact Sheet Prints

Printer

(J Printer | Image Text Settings },
i

Properties

Media :
Ad |

Media orientation:
) portrait 1.

C Landscape

Media size: I
209.9 mm x 297.0 mm

Print profile:

CMYK profile:

( CMS settings...

Apply B Cancel Print )}

Print preview

A/

== To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.94).
If CMYK simulation has been set, the image is printed in the set
colors (p.94).
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro and Print Studio Pro, you can print with
DPP by a simple operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP and Easy-PhotoPrint Pro, first install Easy-PhotoPrint
Pro version 1.3 or later on your computer.

Printing with DPP and Easy-PhotoPrint Pro
Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].

Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

AN/

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.94) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.146), and try printing.

/

> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.78, p.94), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction

When the color space setting (p.78, p.94) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with DPP and Print Studio Pro
Select the [File] menu » [Plug-in printing] » [Print
with Print Studio Pro].

Print Studio Pro starts up.

Specify required settings for printing photographs,
and then print.

Refer to Print Studio Pro's Instruction Manual for details on
settings.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.96) is not applied.

Y

~@< Advantages of printing with Print Studio Pro

Printing with faithful colors

When a color space is set (p.78, p.94), it is automatically transmitted
from DPP to Print Studio Pro, allowing you to print with faithful colors.
Printing with a wide color reproduction

When the color space setting (p.78, p.94) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Introduction

Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format

Contents at

imagePROGRAF printer. To print with DPP, first install imagePROGRAF a Glance
Print Plug-In for Digital Photo Professional on your computer. - :
Select the [Digital Photo Professional] menu »
Select the [File] menu » [Plug-in printing] » Plug-In [Preferences]. o Basig
for the printer you use. The [Preferences] window appears. peration
The Plug-In starts up. Select the tab sheet, specify the settings, and then
Specify the required printing photographs and then click the [OK] button. ggg;‘t‘i;gg

print.

? Additional information

A single image can be printed at a time

Preferences

{[ General settings View settings Tool palette Color management ]

Startup folder

(*) Last displayed folder

Advapced
Imag iting
and Pfinting

You can print a single image selected in DPP at a time. When printing us‘iTe"'“'“' D Processing
multiple images, perform printing for each image individually. = ' Largj;ceI Numbers
. . . s i of Images
Functions set in DPP that are not applied to printing 2": 'elc'-"e — E
s . . . - isplay message when adding file
Specified output resolution (p.91) and CMYK simulation (p.94) are not )il o fie akisaesiatically Editing
app“ed' Viewing and saving RAW images JPEGI/TIFF
@ High quality {recommended) Images
M, | Wiew images at high speed (moiré reduction off)
2= Advantages of printing with imagePROGRAF Print Plug-in s View/save R.:Wlmagesathigh quality
Mairé is reduced and the NR tool palette can be used
Printing with faithful colors , , Reference
. . . . JPEG image quality
When a color space is set (p.78, p.94), it is automatically transmitted (3 Resove block noisetared shosquits mofse
from DPP to the Plug-In, allowing you to print with faithful colors.
e . . . Default value of output resolution
Printing with a wide colqr reproduchonl . T Index
When the color space setting (p.78, p.94) is set to a color space wider

than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

Cancel 3 ( oK
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General Settings

You can specify the folder that opens when DPP is started up, image
quality of displayed and saved RAW images, etc.

Preferences

[ General settings View settings Tool palette Color management |

Startup folder

) Last displayed folder
() Specified folder

__ Browse. _ Canon 1/Users/Canonl/Desktop

Save recipe
(%) Display message when adding file
() Add to file automatically
Viewing and saving RAW images
(') High quality {recommended)
| View images at high speed (moiré reduction off)
View/save RAW images at high guality
Moiré is reduced and the NR tool palette can be used
JPEG image quality

| Rermove block noise and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

Cancel ) ( oK )

Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.62) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.62)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied. However, you
can use the noise reduction function.

As the setting is the same as [High quality] other than for image
display, the image undergoes false color reduction processing when it
is saved.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window,
and the time it takes to save a RAW image is shorter than with [High
quality].
You cannot use the noise reduction function (p.62).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

@ For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.
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JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.42, p.101) and for JPEG images that
have been saved with a different name.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.42, p.101).

View Settings

You can specify settings relating to the display.

Preferences

GCeneral settings | View il | Tool palette Color management

Grid pitch

64  Pixels(8-256)

Locking selected image

a Images opened in Edit window remain selected in main window

Magnification in Edit window
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® Fit to window ) 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

) 50% ) 100% ) 200%

RAW and JPEG

| E Display only CR2 images for CR2 and JPEG files of the same name

Sort order in main window

# Retain sort order

Highlight/shadow warning

Highlight 255 (192-255 [N
Shadow 0 (0-64) ]

Quick check tool display

® 50% ) 100% (moiré reduction off)

{ Cancel ) f‘

0K

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

92



Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you quit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you quit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.55).

Tool Palette

You can specify settings for the tool palette.

Preferences

. General settings View settings | Tool palette | Color management

Default settings of RGB Tone curve mode

Tone curve mode Tone curve interpolation method Histogram
M RGERGE ® Curve () Before adjustment
") Luminance R G B ) Straight ) After adjustment

Tool palette display in Edit Image Window
# Docking display
_ Floating display

‘Modified Picture Style settings
E Retain settings of each Picture Style

_J‘_@I palette display mode

! Same for Main window and Edit windew

_Default noise reduction settings

\B Apply camera settings

") Set as defaults

RAW luminance noise reduction: 10
RAW chrominance noise reduction: @ S
TIFF/JPEG luminance noise reduction: 1)

TIFF/JPEG chrominance noise reduction: 10 6'—‘

( Cancel 3 f 0K 3

Default settings of RGB Tone curve mode

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.
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Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed or retained,
when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
* When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
» When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

AL/

=@> Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

+ General settings View settings Tool palette Color management }

Default settings of Work color space
¥ sRGB

") Adobe RGB

) Wide Gamut RGB

") Apple RGB

) ColorMatch RGB

CMM settings for print_

For display :
%) SRGB

" Monitor profile
E ENG/Library/ColorSync/Profiles/Displays/Acer AL1922-1CAB49B4.icc

Printing profile:
None 4

Rendering intents:

CMYK simulation profile: Rendering intents:

None } :j

Rendering intents when using Easy-PhotoPrint
" Perceptual

¥} Relative Colorimetric

Cancel \ (’ OK ‘)
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Default settings of Work color space

You can select from five types of color space (p.146) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.101) or printed (p.43, p.46, p.49, p.86 to p.90).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.126, p.127), the edit window (p.129), and the edit image
window (p.135).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.78).

Display setting (color setting of the monitor)
Where a profile (p.145) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.

Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

AL/

-2@3 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.

Setting of printing profile (color setting of the printer)

Where a profile (p.145) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.49, p.86, p.87) except for printing using a Canon inkjet
printer (p.43, p.46) or linked printing (p.88, p.90).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

== Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.43, p.46) or using
linked printing (p.88, p.90), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.
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Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.146) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.126, p.127,
p.129, p.135) in the bottom of the main window, edit window and edit
image window, and colors can be checked.
To temporarily cancel CMYK simulation, press the <space> key.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.146) for printing
using Easy-PhotoPrint (p.46).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptual].
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4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
here.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

Introduction
? Additional information

applied to another image. Recipe data includes tool palette contents

s . . A . . . . . Contents at
You can edit images efficiently by selecting and adjusting one image Recipe data includes adjustments made with the tool palette ([RAW], a Glance
from images shot with the same shooting environment and batch [RGB], [NR/ALO] and [LENS]). For this reason, other editing content
applying the adjustment results to a large number of images. such as trimming or dust-erasure (copy stamp) is not included in the
nnn < IMG_000L.CR2 reCipe data. Basic

R Recipes adjusted with the [RAW] tool palette can only be applied Opsration

[t 4 =] to RAW images

e - : Adjustments in the [RAW] tool palette, which can only be made for

[fie berce adfotmens. = RAW images, are not applied to a JPEG or TIFF image even if they LR
1~ 1] 2] s |C Reaister.. Operation
Shot settings |:]l( Tune... | are paSted

Picture Style &=3 Advanced
= oo ) Image Editing
R and Printing

' Procg§sing
— Larg bers
-10.0 “8.0 -60 -40 -20 0 20 4D of Im ges

Contrast: O
Highlight- L v i— Ed.t-
hadow: ———r . . Itin
=z BRbne Contents adjusted using the tool JPEG/T IQI’=F
Color tone: i s palette can be handled Images
o, = o individually as a recipe file

Stength: oo (extension “.vrd”).

Firieneas o Reference

Threshald: R T e J—

Index
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|§| The adjustment contents of JPEG or TIFF images (p.105) can be @
saved as a recipe file (extension “.vrd”) and loaded and applied to

another image in the same way as with RAW images. 98



Introduction

Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu » [Save recipe in file].
The [Save] dialog box appears.

Select the destination folder, enter a file name, and

and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. Oparation
The recipe is copied.
? Check the contents of a recipe file by pasting to an image Select the image to Whi_Ch the recipe is to be' applied Sg‘;?;‘ﬁﬁﬂ
o . _ and then select the [Edit] menu P [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image g
T : selected image].

and check the settings in the tool palette. When only a few settings are W , , Advanced
adjusted, we recommend you use a file name that describes the The recipe is applied to the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which a recipe is to be copied

a Glance

ProceS§sing
Larg bers
of mes
Loading and Pasting Recipes -~
iting
Select the image to which a recipe is to be applied, J'T'E‘:"';':F
and then select the [Edit] menu » [Read and paste g
recipe from file].
The [Open] dialog box appears. Reference
Select a recipe and click the [Open] button.
The recipe is applied to the image.
Index

00
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific . :
shooting environment can be registered as personal white balance. You Applymg Personal White Balance

can then perform efficient white balance adjustment by applying this In the main window, select the image to which white
personal white balance to a large number of RAW images shot in the balance is to be applied

same shooting environment.

Click the [Tool palette] button on the toolbar.

. . - The tool palette appears.
Registering Personal White Balance paletie app

Adjust the white balance (p.27, p.28, p.56).
To adjust white balance, select a setting other than [Shot

Click the personal white balance number button that
is to be applied.

settings] from the [White balance adjustment] list box (p.27). You ~— | RAW | RGB  NR/ALO LENS |
will be unable to register the adjustments if you select [Shot | Brakimass adisunem E
settings]. —— e
In the [RAW] tool palette, click the [Register] button. [White balance adjustment (o]
The [Register personal white balance] dialog box appears. @ [@_1 N 'T_j Register... )
Select the button number to be registered from the Daylight ML Tune. )
list and click the [OK] button.
BN [#| Register personal white balance ‘Pmum > E.J
Register current setting in personal white balance Standard ) ( Browse.. )
Current setting: Click white balance £ 2

[ Custom 1 f :]]

{ Cancel | E——ak—

n—l[l'.[l -3.0 -6.0 -4.0 -20 O 2.0 4.0

Contrast: 10) "-_—‘ET_-_"

Highlight: R —

Shadow: o ’_..e’_
|| Linear

Colar tone: 10 TQ._-

Color saturation: (0] F,-,_Ey_,-

Unsharp mask s
Strength: 10 aﬁ
Fineness: o h
Threshold: () e’—..q
® You cannot change or adjust white balance with multiple-exposure . . : i
RAW images created on the camera, Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar
(p-126).
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

Batch settings

Save folder

IMG_0001.CR2
IMG_0002.CR2 ENG/Users /canonfDesktop (" Browse Y

IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2 Kind of file Exif-TIFF 8bit 3]
IMG_0006.CR2 i D 1o
IMG_0007.CR2

IMG_0008.CR2 Qutput setting

IMG_0009.CR2 -

IMG_0010.CR2 Qutput resolution 350 dpi @ Embed ICC profile
IMG_0011.CR2 Resize setting

IMG_0012.CR2 ! Resize
IMG_0013.CR2 Width Height Unit

File format

IMG_0014.CR2 3456 | x 2304
IMG_0015.CR2 (3456 pixel ) {2304 pixel )

ot

File name

@ Current file name
String

C, New file name
String Sequence number
DPP_ 0001

Ex. IMG_0001.TIF, IMG_0002.TIF

Image transfer settings
! Open image using software

{ Browse.. )

( cancel “ € Execure ) '

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Terminate] button appears in
the batch processing dialog box.

In the processing dialog box, click the [Terminate] button.

? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.41, p.121) to edited RAW images.

5\@/5 To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

@< skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

® If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected images.

@ If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.113) or dust-erased image (p.73 to p.77, p.116 to p.120)
actually becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, see p.143.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike Select Photoshop CS.

[Transferring a RAW Image to Photoshop] (p.78), you transfer images In the [Open] dialog box, select a Photoshop CS file or an alias
that have first been converted and saved as a seperate image, so the and click the [Open] button.

transferred image will not disappear after quitting the destination

Introduction

Contents at

software. The software used here as an example is Adobe Photoshop The [Open]. dlalog. box clpses and [Image transfer settings] in the a Glance
CS. [Batch settings] window is set to Photoshop CS.
Checkmark [Open image using software]. Basic
In the main window, select multiple images to be e Operation
tranSferred. @pen image using software
. Adobe Photoshop CS [ B T
Click the [Batch process] button on the toolbar AT e Advanced
(p-126) ( cancel ) Execute ) Operation

The [Batch settings] window appears.

Click the [Execute] button.

. . . . . . . Advanced
Perform settings required for transferring (e.g. file The processing dialog box appears and batch transfer begins. Image Editing
format). When the first image has been transferred, Photoshop CS starts and Printing
. up and transferred images are displayed in transferred order.
Click the [Browse] button. Procedsing
Batch settings Larg beI'S
IMG_0001.CR2 St of Im ges
IMG_0002.CR2 MacOSK /Users /canon/ Documents © Browse.. )
MG_0003.CR2 File format
::Eiggg:ﬁ;i Kind of file Exif-JPEG 5] Editing
o0t 2 iy T8 4, JPEG/TIFF
IMG_0008.CR2 Glliput =ting Images
IMG_0009.CR2 -
IMG_0010.CR2 Output resolution 350 dpi @ Embed ICC profile
IMC_0011.CR2 Resize setting
IMG_0012.CR2 ! Resize
IMG_0013.CR2 Width Height Unit Reference
IMG_0014.CR2 3456 x 2304
IMG_0015.CR2 (3456 pixel {2304 pixel )
v
File Name
) Current file name
String
Index
@ New file name -—

String Sequence number

DPP_ ool * [ Save sequence number

Ex.: DPP_000L.PG, DPP_0002.JPG

Image transfer settings

# Open image using software

- ' iisrowse. 7_‘ '

Cancel ) (5 Execute )

© If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected
images.

The [Open] dialog box appears.
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Batch Change the File Name of Images .
Introduction
In the main window, select multiple images of which . . . . .
. hanging the File Name of Images in the Order in the Main Window
the file names are to be changed. Cha ging the File Name of Images in the Order in the Ma do
When you change the order of the images in the main window, you can Contents at
Select the [Tools] menu » [Start Rename tool]. change in one operation the names of the files for the images, in the a Glance
The rename window appears. order they were rearranged.

Specify the required settings (p.144) and click the . . S :
pecily 9 gs (p.144) Change the order of the images in the main window Basic
[Execute] button. Operation
(p.21).

MacOSX/Users /canon/Pictures [Photo /xxxx_xx_xx
A, g In the main window, select multiple images of which
B shoor , = 5] . = . Advanced
DPP ™ Shooting Date/Time ™} Sequence number Do not change the flle names are to be changed. Operation
Sucr"]Finomainwindow SETJL:JZTE numb?r: Save segquence number SeIeCt the [TOOIS] menu } [Start Rename too']'
;. ;l'\‘e Nlan;D - Advanced
o4 SHCRHNG Dotes T Shooting Date/Time ! . . Image Editing
#fc - PHIRLAL % Select [Fit to main window]. and Printing
— Lopy ename MM-DD-YY ™~
MacOSKUsers jcanon /Desktop ™ Insert underbar MacOsX
Procg§sing
Original File Modified File Name Larg bers
::?gggiﬁf i P el e e U giggg:i:gzggg;ﬁ}; A e U FI |E Name of m es
IMG_0002.CR2 DPP_09-13-06_0003.CRZ2 __In L
L St ot o e Editin
i el Basic Settings P B
IMG_0004.)PG DPP_09-12-06_0008.IPG mages
IMG_0005.CR2 < DPP_09-13-06_0009.CRZ < 50”
I:JG,OOOS.JPG . o I E:PP,DB—l}—OB,UDlO.JPG . . ]
R f*) Fit to main window
(_ Cancel —
_ File Name Reference
Processing begins and the file names are changed. __ Shooting Date/Time
"2 Changes cannot be made when the file name is duplicated Specify the required settings (p.144). Index
To copy an image, checkmark [Copy & Renamel].

If a file name in red text has appeared in [Modified File Name], the file name

has been duplicated. Changes cannot be made if even one file name has Click the [Execute] button.
been duplicated. Change the settings so that duplication does not occur. The file names are changed and the order in the main window is @ @
® The name of the movie files cannot be changed in DPP. maintained.
[ @ You cannot start up the rename tool from the [Collection] window (D) If the message [Insufficient memory.] appears, too many images are
(.36, p.127). selected at the same time. Decrease the number of selected
For a list of the rename window functions, see p.144. images.
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5 Editing JPEG and TIFF Images

DPP is software mainly aimed for advanced RAW image editing, but it
also has JPEG and TIFF image editing functions. Here, the editing and
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saving of JPEG and TIFF images are explained. a Glance
Editing JPEG and TIFF Images...........cccevveiieeenenes 105 ]
About the RGB Tool Palette ............oovovverveerrerrenn. 105 | opeiotion
Automatically Adjusting Brightness and Color (Tone -
CUNVE ASSISt) ...uvviiiiiiiieeeee e 106
Adjusting Brightness and Contrast ...........c..ccccco...... 107 ‘gg‘é*r‘:t?gg
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/ALQO] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

Slaja [¥ IMG_0015JPG
{ RAW | RGB | NR/ALO LENS |
Tone curve assist lﬂ"&|@ ]
Tone curve adjustment &J
R <+ 7|
|
255
i
|
|
|
|
0 e N
™ o] 255 EI{I
Erightness: .‘.‘.\...‘.Ea..‘....... 0 i p—
Contrast: —.‘.‘.‘...‘6—....‘....... UE
— Contents adjusted using the tool
Satindin palette can be handled
Snarpness: individually as a recipe file

(extension “.vrd”) (p.98, p.121).

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.121), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.98, p.121).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.110) and
automatic adjustment (p.106), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.145). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

! RAW RCB NR/ALO LNS"
[Pomane essisi {——Reverts the tone curve
Tone curve adjustment to the original settings
. O 2]
7 — — .
255 - High
Standard
D J
0 255
Brightness: ,fi'll IZIE_
Contrast: ez
Huse!
Saturation:
Sharpness:

The tone curve changes as adjusted.

|
\\/

== Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

» Images which have extreme backlighting

@ If you click the [[[Z%]] button, the tone curve as well as the [Hue]
and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.109).
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Introduction
. . . Brigh Y the slider to the right t k i
Adjusting Brightness and Contrast fightness: Move the slider to the right to make an image —
brighter and to the left to make an image darker.
The brightness and contrast of an image can be adjusted. Contrast: Used to adjust modulation and degree of contrast S
of color. Move the slider to the right to make a Glance
~———— RAW | RGB NR/ALO LENS - contrast of an image stronger and to the left to -
Tone curve assist Ol O+ 2o make contrast weaker.
‘Tane curve adjustment L— | Basic
; El Operation
R R o s | ]
— .
255
Advanced
Operation
Advanced
Image Editing
and Printing
Processing
\ - Large Numbers
; ! ; of Images
S— Drag the sliders left or
0 255 . E g
. = rght JPEGIIFF
Brightness: ; - l | es
Contrast: —{&]— ) Enter numerical values
Hure! )
Saturation: Reference
Sharpness: -
Index

00

107

@ The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[~]] button.

- RAW | RGB | NR/ALO LENS

‘Tune curve assist : 7 H E+HE§ |
Tone curve adjustment L“_‘) |
R|c|s|

]
[ |
A
L

=

(om) (oml (ond| (amd (o)

Eﬁghm!551 ||||||||||'if||||||||||

Contrast: — 0
PR e e
Hu& PR ey e LEJ D
& X3 ¥ ¥
Sa‘ufﬂtlﬂ'r‘:_ PR Yre e lg} lDD

Shafﬂ“!“: E|||||||||||||||||||l LEJ o

Click on a point that is to be the standard for white.

ana ¥ Digital Photo Professional - | MacOSX Users fcanon (Pictures |Fholo xxo xx. s [IMG_0010. PG |

(0587, 5471 306 222, 333

The coordinates of the cursor position and the RGB values (8-bit
conversion)

=» The color of the image is adjusted with the point you selected as
the standard for white.
If you click on another point in the image, the white balance is
adjusted again.
To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

5

The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.93).

J
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Introduction
. - - Hue: M the slider to the right t k lor t
Adjusting Hue, Saturation and Sharpness ue ove the slier to the right to make color tones
more yellow, and to the left to make color tones
You can adjust hue (tone) and saturation and make the overall redder.
atmosphere of an image harder or softer : : ; Contents at
P 9 : Saturation: Move the slider to the right to make the color a Glance
deeper, and to the left to make the color weaker.
" RAW | RGB | NR/ALO LENS | Sharpness: Move the slider to the right to make an image ]
‘Tone curve assist (0] @J| harder, and to the left to make an image softer. OpBear;?on
Tone curve adjustment L:-_-,_J
TR s [c 8] H
255 ' Advanced
Operation
Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
0 e | E g
Brightness: .........‘.5_9.......... 0 i s
Contrast: 0 j
Huse: (ol o Reference
Saturation: —(9] 100 :—} Enter numerical values
Sharpnaess: . £y 0 i._
Index
Drag the sliders left or right 2> Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]

or [200% view]. If the view is set to [Fit to window] (full view), the @ @

sharpness will seem unnatural.

|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation, @
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.145).

Select the tone curve mode and interpolation

method.
- RAW RGB MNR/ALO LENS
|T|:me CLFvE assist Ol 2 ‘
Tone curve adjustment | = ‘
RGE R ' G '| B | :9"
ESl A
/
/
Py
/
¥
v Curve
Straight o
<control> + click inside
v RGERCEB the graph to display the
Luminance RG B menu
_ Zree—
A
il
s
s
ol/ |
0 255
Brightness: TR A D+
Contrast: A ....{._?. T R E
Hue: i B
Saturation: ....(._3“ ey "b_" 100 i
Sharpnass: [ T— ) n :

Make adjustments.
Batch adjusts RGB

Adjusts each channel

+ RAW | RGE NRfALO ~ LENS |
|Tone clrve assist Wl B Eb‘
Tone cprve adjustment = ‘
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Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[]] is 8.
To delete a [[]], double-click on the [[].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any
adjustments (p.93).
The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.93).
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Introduction
Adjusting Dynamic Range The setting range of shadow points is 0 to 247 (in 1-stop
D : idth of aradati ion) f dark points to briaht increments when entering a value).
pgiafsrr}lr?;ini?nea(gvg canobgr: djié?g dexpressmn) rom dark points fo brig The setting range of highlight points is 8 to 255 (in 1-stop Contents at
' increments when entering a value). a Glance
The histogram display changes according to adjustment. You can
Move downwards also fix the histogram display to the display before any
Output highlight points adjustments (p.93). Basic
Operation
! RAW | RGB | NR/ALO LENS -
Tone curve assist lﬁ” I+ ”@‘
Tone curve adjustment - j—— Reverts the Advanc_:ed
y—--;lﬁ'?wﬁu 1' 7 ! % ! T ! !? |mage to the Operatlon
Output s Ong_mal
highlight point settings Advanced
numerical Image Editing
value and Printing
Processing
Move to the — Move to the Large Numbers
right left of Images
Input shadow Input highlight
points points E g
JPﬁIFF
1 es
Outputshadow — ¢
pointnumerical 0 it Input highlight
Co ras} —— o value
Input shadow — i _D‘:'
point numerical | Hue: P e—— )| O]
value Saturation: f@f:& 100 j_ Index
Sharpness: e e I--b-: DE ]

Move upwards
Output shadow points
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The horizontal axis shows the input level and the vertical axis shows
the output level.



Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.
|Naise reduction

RAW ﬁ NR Preview... |

The [NR Preview] window appears.

Adjust an image.

enn NR Preview

Navigator
window

— Enlargement

display
TIFF(JPEG position
Luminance noise reducj
o s = Drag the
Chrominance noise redj .
e - ———— x sliders

4 Cancel ) ( Apply )

|
NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

ALy
N

- To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.131) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

|§| If [Luminance noise] has been set, resolution may be reduced
along with reduction of noise.
If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.
You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.93). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.
For a list of [NR Preview] window functions, see p.133.
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Trimming and Adjusting the Angle of an Image

Adjust the angle of the image as needed.
Trimming/angle adjustment window

# 1/1 IMC_D00 1 JPG [3456 & 2304]

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes

vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range

will only be masked in black and the image will not be trimmed.

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

.

Ouick Stamp Frinmming
check

The trimming/angle adjustment window appears.

Editing can be done once the image is displayed clearly in the

trimming/angle adjustment window.

Largest
possible
trimming
range

Click
(rotate
image left
or right in
90-degree
increments)

|
Drag® (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

|§| When aspect ratio information is attached to an image shot with the

EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark I,
EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M, the trimming range based
on the aspect ratio information is displayed.
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Select a ratio and drag the trimming range.

Cala) % 11 ME_0001 G (1456 x 2504)

Select a
trimming
ratio

Drag the
trimming
range

L7080 = N2ED L DRR3 ) = L ISTT 2 R 1 RR Y

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

11

3:2

2:3

4:3

3:4

5:4

4:5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Circle
[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.
[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.128).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.122).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.128).

» Edit window:

+ Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.121).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark lli,
EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M, the set trimming range
based on the aspect ratio information is displayed. Since the image is
not actually trimmed, you can change the trimming range or revert to
the condition before trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 60D, EOS REBEL
T4i/650D, EOS REBEL T3i/600D or EOS M, its trimming range
cannot be changed nor reverted to the condition before trimming,
since the image is actually trimmed and saved in the set trimming
ratio.”

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.137).

Ay

The image is displayed in its trimmed condition.

* For JPEG images shot with EOS 5D Mark Il and [Add cropping
information] set in Custom Functions, aspect ratio information is
only set and the image is not actually trimmed.

ALy

> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

@ For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

|§| For a list of the trimming/angle adjustment window functions, see

p.137.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Il

EOS-1D Mark Il EOS 5D Mark Il EOS 5D Mark Il

EOS 6D EOS 7D EOS 60D

EOS 50D EOS 40D EOS REBEL
T4i/650D

EOS REBEL EOS REBEL EOS REBEL

T3i/600D T2i/550D T1i/500D

EOS DIGITAL REBEL EOS DIGITAL REBEL EOS REBEL

XSi/450D XTi/400D DIGITAL T3/1100D

EOS DIGITAL REBEL EOS M L

XS/1000D

In the main window, select an image appended with
Dust Delete Data.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

Ty 173 1MC0050IPC [FASE » 1304]

»Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
=>The [8,] mark (p.128) is displayed on an image from which dust
spots have been erased.

® Dust Delete Data is not attached to images having settings specified
during RAW processing on the camera for distortion correction,
chromatic aberration correction, etc. As a result, you cannot perform
automatic dust erasure processing on such images.
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.122).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust

erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.118) or the copy stamp function (p.120).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.121).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.142.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

Sramp Frinmming

The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

BT ) 13 W, 000 P {3484 = 2304]

A = Double-
~— == click

[ Cance - %
[T T e— —_—

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spots to be
erased.
If the dust spot is dark in color, click the [ @»( ) [] button, and if
the dust spot is light in color, click the [ {_»( ) |] button.
When you move the cursor over the image, the dust erasure
range appears as [O].

Place the dust spot to be erased within the [O] and
click.

FTaTsY LT A G0 G [FATE % 2104]

©, ==  Click

&=

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [3] mark (p.128) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.120).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.122).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.121).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <3B> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, see p.142.
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Compositing and High Dynamic Range .
Introduction
: : You can composite images also using JPEG and TIFF images in the
Erasing Unwanted Parts of an Image (Copy Stamp Function) same way as RAW images as described below,
You can correct an image by pasting a section copied from another part Compositing Images (p.78)
of the image to an unwanted part of the image. Creating HDR (High Dynamic Range) Images (p.82) C:rgfanl:(s:eat
Follow steps 1 to 3 in “Manually Erasing Dust (Repair
- ,, | } - L) B -
Function)” (p.118). Starting Up Map Utility T
Specify the section to be copied. You can start up Map Utility using the procedure below.
Click on the section that is to be the copy source while holding Starting Up Map Utility (p.85)
down the <option> key. Advanced
] ] Operation
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy Advanced
Source position]. '?:(?%Eg;f%g
Correct the image.
Click or drag on the section you want to correct on the image. [+] Processing
. . - - Large Numbers
in the window indicates the copy source and [Q] indicates the of Images

copy destination.
The copied image is pasted in the position to which it was

Editihg
dragged. JPﬁIFF
For [Pen type], you can select from [Brush] (the pasted image’s In#fGes
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Reference
Click the [OK] button to return to the main window.
The [8,] mark (p.128) is displayed on a corrected image.
Index

00

120



Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.105 to p.112)
as well as the trimmed range (p.113) and dust-erasure (p.116 to p.120)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

Open in Edit window E{ 0]
Open in Edit window (enlarged)

Clase all

pen wir 1OWwW N
Close window W
Save £

Save As... {385

Add thumbnail to image and save {r3T
Convert and save... D
Batch process... F*B

Create new folder... {r3EN
Page setup... {r 3P

Print... #P

Print with dertailed setting... 3D
Contact Sheet Prints... ~¥P

Plug-in printing b
Add to collection ®G

Remove from collection {4+ HG

Clear collection

Delete 3 <
Info... |

Your adjustments are saved to the image.

Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.105 to p.112)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.113) or dust-erased image (p.116 to
p.120) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.101)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.98)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.86)

Printing a thumbnail list (contact sheet printing) (p.87)

Printing RAW images on a high-end Canon printer (p.88)
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.105 to p.112), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.113) or dust-erased image (p.116 to
p.120) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.121) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustment

Rotate left L
Rotate right 3R
Apply Dust Delete Data

Work color space >

Tone Curve Assist - Standard
Tone Curve Assist - High

Revert to last saved settings “_3Z
Revert to shot settings ~¥Z

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience

using DPP.

It contains various troubleshooting solutions, how to delete DPP from

your computer, explanations of the various windows and a glossary.
ot An Index is provided at the end of the chapter for you to easily find

information you are looking for.

Troubleshooting..........coiiiiiiiiiiii e, 124
Deleting the Software (Uninstalling) .............cc....... 125
List of Main Window (Folder Window) Functions .. 126
List of Main Window (Collection Window) Functions... 127
Image Frame Information in the Main Window and Edit

Image Window ..o 128
List of Edit Window Functions ..........cccooovivvieniennnnn. 129
List of Tool Palette Functions ..........ccccovvvvvvenrennnenn. 130
List of NR Preview Window Functions................... 133
List of Quick Check Window Functions ................. 134
List of Edit Image Window Functions .................... 135

List of Convert/Save One Image Window Functions....... 136
List of Trimming/Angle Adjustment Window Functions.. 137
List of Lens Aberration Correction Window Functions... 138
List of Digital Lens Optimizer Adjustment Window

FUNCLIONS ..., 139
List of Compositing Tool Window Functions............... 140
List of HDR Window (Adjust Image) Functions ..... 141
List of Copy Stamp Window Functions.................. 142
List of Convert/Save Multiple Images Window (Batch
Processing) Functions..............ccccceeiiiiiiiiiieeceeees 143
List of Rename Window Functions........................ 144
(€110 115 145
INAEX .. 147
About This Instruction Manual.............................. 151
Trademark Acknowledgments.................cc........... 151
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

The card reader does not detect the SD card.

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.73 to p.77, p.116 to p.120) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.130).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.126, p.134, p.135),
trimming (p.38, p.113), dust erasure (copy stamp) (p.73 to p.77, p.116
to p.120) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.130).

The Auto Lighting Optimizer (p.61) is a function that is only available
for RAW images shot with EOS-1D X, EOS-1D Mark IV, EOS 5D
Mark 1ll, EOS 5D Mark Il, EOS 6D, EOS 7D, EOS 60D, EOS 50D,
EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/
550D, EOS REBEL T1i/500D, EOS REBEL T3/1100D and EOS M.
You cannot apply the Auto Lighting Optimizer’s adjustment contents
to RAW images shot with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.78,
p.94) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sSRGB color space. In this case, set the RAW image color space
to sRGB, convert again to a JPEG or TIFF image and save, and then
view this image.

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF

Images

Reference

00

124



The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.94) and a profile for a printer is
set up correctly (p.94), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43, p.46) or linked printing (p.88, p.90) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL may not display image information
(p.10, p.23).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

P
| W2

Address Book Automator Calculator

® -

Font Book Front Row Image Capture

XX

iTunes Photo Booth Preview chleme Player Safari Stickies

V@

System Preferences TextEdit Time Machine Utilities Open in Finder

Drag the folder for the software to be uninstalled to
the Trash.

Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

@ You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF

Images

Reference

125



List of Main Window (Folder Window) Functions .10 S
Shows/hides the tool palette (p.130) Image information (p.23) Cancels selection of all images Displays the trimming/
Shows/hides the folder area Selects all images Displays the quick check window (p.134) angle adjustment
Switches to the edit image ‘ Displays the copy stamp window (p.142) v‘vmdow (p-137) Contents at
window (p.135) | - A , , , a Glance
@ Digitpl Photo|Professjonal Fil{ Edit |View Bookmark Label |Adjustmlent Tpels Window Help E 4 Wed 10:48 AM Q l
Digital Photo Professipnal - [ MacOSX/Users/canon/Pictures/Photo/xxxx_xx_xx ] - F0|der path —
Toolbar*! Batch conversion/
[Collection] tab sheet*> e - : saving 0:;212’0“
[Folder] tab sheet*® _fFolder Collection(®) - = (p.101, p.102, p.143)
:L; SD:"I"“"’ : — Image rotation Ad .
e (90 degree Op‘é?:ggn
Check mark (p.19) - increments)
8 e 2 e G002 Ch WO | | WO — oo Rating (p.19) Advanced
v 3 paures ' @ N ' Image Editing
- and Printing
» O shared Processing
= Large Numbers
Folder area*? o o of Images
@ MG.O000TERZ ~ MGOD0ACRZ gy MGODDICRZ
Editing
JPEGI/TIFF
7 Images
=
_ ~ MG O0LL.CRZ _de ~ MGO0IZERZ ~ MG ODI3ERZ ~ IMG.ODI4CRZ Reference
;-'ﬁaﬁﬁﬁﬁﬁﬂ J Adobe RGE High|qualitv Recipe data: Yes Number of images: 15 Number igf selected images: 1 CHYK ,/',',/5_‘— CMYK SimU |ati0n
Image color space and workJ Display mode** ‘ Number of selected images display (p-94)
*3
color space™ (p.78, p.95) Recipe attachment status (p.98) Number of displayed images @ @
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.91) of the @
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed. ~
thumbnail list on the right. *5 You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette. 126



List of Main Window (Collection Window) Functions (3¢ S
Image information i - i i i
Shows/hides the tool palette Selects all images Cancels selection of all images Displays the quick check window e
) o g Displays the copy
Switches to the edit image ‘ stamp window Contents at
window ,| a Glance
@| Digital Photo|Professional Fil§ Edit |View Bookmark Label [Adjustnient Toels Window Help E 4 Wed 9:46 AM Q
an0n 8 Digjital Photjo Professianal - [Collection] e —
Toolb L .
(?0” a[. tab sheet*’ ) Batch conversion/ Basic
[Collection] tab shee 7 saving Operation
[Folder] tab sheet Folder
— Displays the trimming/
angle adjustment Advanced
window Operation
— Rating
oI B = : E0 T ; Meoeee | : Advanced
| i Image Editing
I(g}? gigrféztlon and Printing
increments)
Procrﬁssitr;g
Large Numbers
— Check mark of Images
Editing
JPEGI/TIFF
Images
Reference
 Adobe RGB | Adobe RGB T Recipe data: No Number of images: 7 Number of selected images: 0 VK v g CMYK simulation
| | .
Image color Space and work —— Display mode ‘ Number of selected images display
color space™ (p.78, p.95) Recipe attachment status Number of displayed images
*1 The total number of images added to the [Collection] window is *2 Displays the coordinates of the cursor position and the RGB values (8-
displayed in the (') in the [Collection] tab sheet. Accordingly, when an bit conversion) when click white balance was performed with the tool
image is added that is displayed as a single image (p.22), twice the palette.

total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window (.10, p.34) S
Information displayed when [Large thumbnail] (p.10) is selected ]
[ M) Digital Photo Professional - [ Canon 1/Users [Canonl /Desktop/xxxx_xx_xx ]
S - = - _ . a Glance
=i = i = W s & & /7 —
Digital Lens
Optimizermark Basic
Folder Collection(0) (P69 10p.73) R
Check mark ¥ S MacOSX 1
(p.18, p.19) b= ¥ applications Copy stamp Advanced
[ % Temporary Items L mark Operation
¥ [& Users (p.73 to p.77,
v @ canon p.116 to p.120)
¥ [ Desktop i Advanced
[ Travel — Lens . Image Editing
B2 aberration and Printing
Rating mark — - Docements correction
(p.18, p.19) P i Library mark (p.65) -
[ Movies Tri L:rocrﬁssgg
. ® nican | Trimming rge Numbers
Brllghtness -"f_!---- range** of Images
adjustment ¥ | Pictures (p 38, p 113)
*1 (p.26) v [.# Photo — ot k3
value : 01 B [F13 | iz | Aperture Editin
[C) dokk 1400 IO [1/400] JPEG/TIFF
> P_“b"[ {rra IMG_000ITR2 # s " IMG_0002.CR2 GRS Images
White balance icon*! (p.27) File name GPS mark*> Reference
Unsaved editing content mark

Image type*? Shutter speed*3

*4 When aspect ratio information is attached to an image shot with
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark IIl, EOS-1D Mark I,

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.22).
[RAW] is displayed in RAW images. EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS REBEL T4i/650D,
(In [Small thumbnail] (p.10), [R] is displayed.) EOS REBEL T3i/600D or EOS M, the image is displayed as a trimmed

*3 Does not display with [Medium thumbnail] or [Small thumbnail]. image.

*5 Displayed on images shot on a GPS function-compatible Canon
camera.
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List of Edit Window Functions .11, p.25) .
Introduction
Path and file name of image Tool palette*' (p.130, p.131, p.132) —
B OB #! Digital Photo Professional - [ MacOSX /Users/canon/Pictures /Photo/xxxx_xx_xx/IMG_0001.CR2 ] &a S _l‘f IMG_0001.CR2
[ raw | RGB NR/ALO LENS C:rgfanr::‘s:eat
(=) e
|Whila balance adjustment La” Basic
1] LEEER I Operation
Shot settings | ‘] (_ Tune 3
|Piclure Style |£J‘
: - Advanced
Standard #)( Browse.. ) operation
_ Advanced
o0 ST 50 40 20 n 20 4a Ig‘:dgePrEIg;lt:]ng
Contrast: {0 E——— 9
Highlight: L . . —
hadow: .
S St Processing
Colar tone: ADRST .Q m Large Numbel's
Calar saturation: 10 T@T Of lmages
| Unsharp mask L \‘»]
Strength: 100 m
Fineness: 10) E? S Editing
Threshold: Ll S JPEGI/TIFF
Images
Reference
| 918, 1282 : 79, 81, 93 RAW / Adohe RGE CMYK High guality 7

Display mode**
CMYK simulation display (p.94)
Image color space*3 and work color space (p.78, p.94)

Information display*2

*1 To switch between show/hide, select the [View] menu » [Tool palette].
*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion).

*3 RAW images are displayed with [RAW].
*4 The item selected in [Viewing and saving RAW images] (p.91) of the
[Preferences] window is displayed.
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List of Tool Palette Functions

RAW Tool Palette (p.25)

nnon #| IMG_0001.CR2

{ RAW | RGB | NR/ALO  LENS -

|Efightness adjustment =] J

7] .~ ° Bse L White balance adjustment

| “100 80 60 -40 20 0 20 40

Contrast: SRR

Highlight: oo

Shadow: o —@ i
! Linear

Color tone: 0 T@. i

Color saturation: o 5

i Unsharp mask ! ﬂ )

Strength: ] m
Fineness: ] 6..........
Threshold: 0 6.'—..‘ y

* If an image is displayed enlarged, the enlargement display position can be

| Shot settings P Tune.. ) (p27’ p28, p56)
|Picture Style |£;||. . .
% ~ Picture Style settings (p.26, p.59)
| Standard 0 Browse...
: - Dynamic range adjustment (p.57)

Contrast adjustment (p.29)

Shadow/highlight adjustment (p.57)

Linear setting (p.29)
Color tone and color saturation
adjustment (p.29)

Sharpness adjustment (p.31)

RGB Tool Palette (p.60)

Sharpness = ]
Sharpness: (1) T—
\_

Enlargement display position*

moved by dragging. The enlargement display position appears when

[Docking display] (p.93) has been set and the edit image window (p.135)

has been enlarged.

o [#| IMG_00D1.CR2
I. RAW | RGB | NR/ALO LENS -
|Tcne Ccurve assist _ﬂji&i@_’!
Tone curve adjustment |3J
PREE v o8] [ ]
255
0 J
(o} 255
Brightness: I vl 0 1
Contrast: T 0 ;
Hue: o B | ) o :
Saturation: "ﬁ'}" [b] 100 :
Sharpness: I ]

Automatic adjustment
(tone curve assist) (p.33, p.106)

Click white balance (p.108)

- Tone curve adjustment

(p.58, p.110)

- Dynamic range adjustment (p.111)

Brightness and contrast
adjustment (p.107)

Hue and Saturation adjustment
(p.109)

Sharpness adjustment (p.109)

Enlargement display position*
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NR/ALO Tool Palette

(When a RAW image is selected)

0 1% IMCG_1001.CRZ

RGB | MRfALO

- RAW LENS |

IAuto Lighting Optimizer

. S -

i Low  Standard  Strong

- Auto Lighting Optimizer (p.61)

|N'|:|ise reduction

RAW

__seehy__ri—— Apply noise reduction button (p.62)
nieevien. 7 Displays the [NR Preview] window

(p.62, p.133)

[ Luminance noise reduction

in 0 'Ea L, 20

J— Luminance noise reduction for

RAW images (p.62)
——— Chrominance noise reduction for

& D i 20
TIFF /JPEG

Luminance noise reduction

(0) 05 20
Chrominance noise reduction

(0 [ T

RAW images (p.62)

——— Enlargement display position*

* Ifanimage is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.93) has been set and the edit image window

(p.135) has been enlarged.

NR/ALO Tool Palette

(When a JPEG or TIFF image is selected)

slale I¥ IMC_10D1JPG

RCB | NRfALO

| RAwW LENS |

| Auta Lighting Optimizer

Low  Standard Strong

[Waise reduction ey i Apply noise reduction button (p.112)
RAW L neeeview. J—+—— Displays the [NR Preview] window
Luminance noise reduction (p1 127 p1 33)
(o (% 20
Chrominance noise reduction
(0 (T - 20
TIFF/JPEG
( Luminance nois# reduction ]— Luminance noise reduction for
B 2 = JPEG and TIFF images (p.112)
A o= 9 3 | Chrominance noise reduction for

JPEG and TIFF images (p.112)

——— Enlargement display position*
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Introduction
LENS Tool Palette —
ann ®l IMG_1001.JPG Contents at
' 2 3 a Glance
[ RAW RGE MR/ALO | LENS ]'—
Digital Lens Optimizer e H—— Digital Lens Optimizer adjustment button (p.72)
Setting orr——— Amount of Digital Lens Optimizer (p.70) OpBearzit?on
Lens data Yes —— Lens data status (p.70)
 update.. ——— Lens data Update button (p.71)
Advanced
. - . . . Operation
Lens aberration correction Tune.. Hi—— Lens aberration correction adjustment button (p.65) e
Peripheral illumination QFF Advanced
Chromatic aberration OFF Image Editing
Color blur OFF —— Lens aberration correction (p.65) and Printing
Distorticn OFF
Processing
Large Numbers
of Images
Editing
JPEGI/TIFF
Images

Reference
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List of NR Preview Window Functions (.62 p.112) .
Introduction
Contents at
s 88 MR Preview a Glance
Basic
Operation
Enlargement displa
Operation
Navigator window
Advanced
Image Editing
Image type* and Printing
k|
Luminance noise reduction = ] . .
[{m p & 5 Lummgnce noise Processing
(NREREE . LSRR RREREn! - redUCtIOn LargeNumbers
Chrominance noise reduction ) i ) of Images
o 0.6 20 Chrominance noise
Pttt iiiiel 4-_ reduction .
. . Editing
( cancel ) € Apply 4| Apply noise reduction JPEG/TIFF
5 button Images

Reference

e
00

NR check window

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.
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List of Quick Check Window Functions (.15, p.18)

50% view/100% view (moiré reduction off)/full view*'

File name of image

2/15 IMIG_DIJGZ.CRZ [3456 x 2304]

™
| 50%view |[ Full screen I—

éheck mark

Clear —

l12345|

Rating
| Raject

‘ Check marks (p.18)

— Displaystheimage
in full screen*?

| Removes check
marks (p.18)

. Rating (p.18)

( Pr'e\lrious ) C Next )

Switches between
displayed images

_AF Point

l . Image Information ]

——
( Rotate left ) [ Rotateright )

Displays the AF
points (p.16)

— Displays the image
information window
(p.24)

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Digital Photo Professional] menu and using
[Quick check tool display] in the [View settings] tab sheet. You can
also move the display position in the enlarged display by dragging the
image.

*2 To return to the normal screen, press the <esc> key.

Image rotation
(90 degree
increments)

— Rating (Reject) (p.18)

J
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List of Edit Image Window Functions (.34, p.36)

Shows/hides tool palette Image information (p.23)  Enlargement ratio of displayed image Displays the trimming/

Shows/hides thumbnail display area Shows/hides grid*4 Displays the copy stamp window an%ISe adj1u1s:’;mer11t3v;/indow
Switches to main window ‘ (p.73 to p.77, p|.1 16 to p.120, p.142) (p-| , P13, p.137)
(p126) ||. Digitjl Photo|Professjonal Fflile Edit View Label Adjustment Tools Window Help = 4§ Thud:l4PM @ l |mage path and

: Digital Photjo Professional - [ ENG/Users/canon/Pictures/Photo/xxxx_xx_xx/II1G_0003 |CR2 | —

file name
Batch conversion/

Toolbar saving

[ RAW | RGE NR/ALO  LENS - X 1 01 , P. 1 02’
‘Erighmnssadjuslm\:m Lﬂ‘ (p1 4 p
0.00 p- 3)
‘wmm Dalance adjustment =) |‘ Image rOtatiOn
7] e (90 degree
Shot settings Y Tune.. ) increments)
e =1 Switchesbetween
Standard 5 e | displayed images
- Tool palette
.7 | (p.130)
“10.0 -8.0 60 -40 -20 0 20 40
) . 3 Contrast: ) TR e
Thumbnail display area™ — it oo
Shadow: £ R, .
| Linear
Color tone: (] ‘_e._‘
Color saturation: AT 6 i

Strength;:
Fineness

Threshold

\ED IMG_0005.CR2 Ll

Informatlon dISpIay*2 (1114, 1304) 113,132 172 RAW | Adabe RGB CMYK — _High quality 1 Y

Image color space*! and work color slpace C|MYK simulation display (p.94)
(p.78, p.94)
*I RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).
*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

Display mode*®

*5 The item selected in [Viewing and saving RAW images] (p.91) of the
[Preferences] window is displayed.

*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.92).

J
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List of Convert/Save One Image Window Functions (.42 g
Convert and save
I — File name Contents at
. ! a Glance
Save As: DPP_001 [+]
Types of image ;
_ . Where: | [ Photo k44 Save destination Basic
Type of image Extension Operation
Exif-JPEG JPG File format
Exif-TIFF 8bit .TIF =
TIFF 16bit TIF Kind of file Exif-JPEG K3 deantged
g - - ; = JPEG compression rate*3 peration
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG Image quality e = P
TIFF 16bit+Exif-JPE TIF/.JP ok
6bit+Exif-JPEG 1.JPG Gitaitasing = 25\ Embeds of ICC profiles*2 (p.145) Advanced
; Epel : Image Editing
Resolution*1 SUBA exmion 3150 SR () B erliat pritig and Printing
( Resize setting 4 = = \_ b
P Processing
|| Resize
, o Width Height Unit Large Numbers
Size changing*4 - : : 4 of Images
3504 w 2336 pixel -
{ 3504 pixel ) { 2336 pixel ) ¥y 7
A e Editing
|| Lock aspect ratio ) JPEG/TIFF
Images
(" Cancel ) ( ‘Save }7_ Save

Reference

*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher “
*2 Color space (p.78, p.94) information that is set in an image is attached the image quality becomes.
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size. @ @
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.78,
p.94), the ICC profiles are embedded automatically. @
<
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List of Trimming/Angle Adjustment Window Functions (.3 p.113)

Cancels all the trimming (aspect ratio) information

¥ 1/1 IMG_0001.CR2 [3456 x 2304]

BN

[

[ Full screen

J

J(

Clear

Reset +

pect ratlo
3.00

= 2.00

o B A

il M
Fa} Y
704 |~ 362 |-t

Height

Width
1577

{3 1051 &

10.10 -

[Angle ij

( Rotate left )( Rotate right ﬂ

Full screen display/returns to normal screen

—— Reverts to the condition when the image was shot

— Ratio of trimming range (you can also enter

numerical values if you have selected [Custom])*"

—— Upper left coordinates of trimmed range (you
can also enter numerical values)

+—— Size of trimmed range (you can also enter

numerical values)

+— Angle of image adjusted

(Drag bar, use the mouse to click A/V or enter
numerical values to set angle)

—— Copies the trimmed range and applies (pastes)
it to another image*?

—— Applies the copied trimming range to all other
images*2

A Switches between displayed images*2

{ Center on Screen

]

Level of opacity outside a trimmed range

—— Shows/hides grid lines
(Drag bar to set distance between grid lines)

Displays the trimming range in the center of the

( Cancel

)€

oK )

| (704,362} -> (2281, 1413) = (1577 x 1051)[1.50]

window

)

Trimming range

Displays borders around a trimmed range

Image rotation (90-degree increments)

*1"f [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Qperates when you have selected multiple images and the trimming/
angle adjustment window is displayed.
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List of Lens Aberration Correction Window Functions .65 S
When the list box for selecting an extender is displayed in the To correct distortion aberration of images shot with a fisheye lens,
[Lens aberration correction] window, select the extender four effects can be selected from the [Effect] list box in addition to
attached at the time of shooting from the list box. [Shot settings] normally used for distortion correction. T
[ Nave Lens aberration correction - [IMG_0001.CR2] ] a Glance
‘ R
Operation
—Enlargement display section*"
Advanced
Operation
.\ Reset | Revertsto the condition when the Advanced
S— image was shot Image Editing
and Printing
'.ii:lﬁntln di inform <l .
| Shooting distance information L: e
® slider*2 (p.68) o5 NUMDSS
e of Images
| Peripheral illumination . . L .
R — } Peripheral illumination correction
|| Chromatic aberration = Editing
» - }— Chromatic aberration correction JPEG/TIFF
® Images
) ¢ U }——— Corrects blue chromatic aberration
7] Color biur ) Color blur correction
T Distartion oo} Distortion correction Y
L
Shows/hides position of “
V! Navigator ) enlargement display section
L Grid Grid display
_{ Cancel :} ( oK )

I
Enlargement display position (Navigator display)

displayed at 200%.

|
Corrects red chromatic aberration

50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to the zoom magnification.
The slider is not displayed for images shot with an EF-M lens.

00

*1 The area you clicked on the image (Enlargement display position) is *2 For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF @
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List of Digital Lens Optimizer Adjustment Window Functions (p.69) s

@ When the list box for selecting an extender is displayed in the
Digital Lens Optimizer window, select the extender attached at the
time of shooting from the list box.

i

Enlargement display position (Navigator display)

%

Shooting distance information slider2 (p.73)
Digital Lens Optimizer adjustment (p.72)
[Do not sharpen previews] check box (p.72)

Reference
Enlargement display section*' @ Q

©

139

*1 The area you clicked on the image being enlarged (Enlargement display position) is displayed at 100%.
*2 The slider is not displayed in the Digital Lens Optimizer window for images shot with an EF-M lens.



List of Compositing Tool Window Functions .75

|| IMG_0001.CR2 [3456 x 2304]

1 | 100%view ——+— 100% display (p.80)

e

| IMG_0002.CR2

>

3

e

F:

— Select foreground image (p.79)

—— Thumbnail display for foreground
image (p.79)

<+ — Select composite method (p.80)
- Use RAW compositing (p.81)

Weighting slider (p.80)

[«[«[-]»]»]
e L =t
(3
. OEENS DEEG
i_ Continue )
{ Save As... j

Alignment controls (p.81)

—— Continue compositing (p.82)

J
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List of HDR Window (Adjust Image) Functions (p.s2) s ,ntmductionl

Contents at
a Glance

Basic
PPEP— 44 Select an effect (p.84) Operation I

Advanced
Operation

Adjust tone/color (p.84) Advanced

Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
Adjust detail emphasis (p.84) JITEEQI’LEF

Reference

Save As...

e ose

Index

=
00
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List of Copy Stamp Window Functions (.73 to p.77, p.116 to p.120)

[# 1/2 IMG_0050.CR2 [3456 x 2304]

|10k vew || Fullsize view -+— FUll SCreen display/returns to normal screen
(_pply bust Delere pata ———— Applies Dust Delete Data (p.73, p.116)

[; 8:“0 I 5:’0 ' Type.s_of dust to be erased (p.75, p.118)

— ... —— Specifies the copy source (p.77, p.120)

_ Fix Copy source position ———— Fjxes the copy source position (p.77, p.120)
("g::h — ]— Types of stamps (p.77, p.120)

Sets the size of the dust erasure range (p.75,
- —p.118) or copy range (p.77, p.120) in a range of
5to 100 (in one pixel increments) (you can also
enter a numerical value)

-— Restores/redoes the image

Copies the dust erasure range or copy range and
applies (pastes) it to another image

Switches between displayed images*

Set to 100% View to perform stamp operation. %

* Operates when you have selected multiple images and the copy
stamp window is displayed.

}
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List of Convert/Save Multiple Images Window (Batch Processing) Functions .101)

Batch settings

Introduction

| PTE————— Save folder
ke TR R ~ H— Save destination Contents at
IMG_0002.CR2 MacOSX /Users canon/Documents Browse... | a Glance
IMG_0003.CR2 ;
File format

IMG_0004.CR2 : :
IMG_0005.CR2 %{ Kind of file | Exif-JPEG -4 I
Ve Tz ey :? 10 — JPEG compression rate*3 (o] IE,’aSIt?

_ _ IMG_0007.CR2 i e p peration

File names of images to be IMG_0008.CR2 Output setting Resolution*?
batch saved IMG_0009.CR2 s .
IMG_0010.CR2 Output resalution 350 dpi [ Embed ICC profile —— Embeds ICC pr0f||es*2 (p’]45) Advanced
IMG_0011.CR2 (Resize setting ) Operation
IMG_0012.CR2 | Resize
IMG_0013.CR2 Width Height Unit . . *4
IMG_0014.CR2 3456 B 2304 Slze Changlng
IMG_0015.CR2 (3456 pixel ) {2304 pixel ) Advanc_eg
et bl
|| ¥ Lock aspect ) Image Editing
= S and Printing
Filename. & 40 Fne b

Types of image

. Current file name

r_lﬂage_tr:?\ns_fer settings
! Open image using software

o

Browse...

Ly

’ Convert RAW images only \ /

Cancel \ f

Execute }

Batch transfer to other image
editing software (p.102)

Images to be converted are limited to RAW images*>

Save

Type of image Extension String Processing
Exif-JPEG JPG | La;%elrﬂ:glg:rs
Exif-TIFF 8bit TIF B e File name
TIFF T6bit TIF PR il Editing
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG DPP_ 0001 _ Save sequence number JITS(:HIFF
B B Ex.: DPP_DO01.JPC, DPP_O002.IPC ges
TIFF 16bit+Exif-JPEG | .TIF/.JPG L )

Reference

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.

*5 Appears when you click the [Batch process] button (p.126, p.135)
without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.78, p.94) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.78,
p.94), the ICC profiles are embedded automatically.
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List of Rename Window Functions .103)

MacOSX /Users/canon/Pictures/Photo/ xxxx_xx_xx

Order in which images are sorted

Checkmark to apply the same
name to RAW images and JPEG
images recorded simultaneously

Checkmark to copy the images
Click the [Browse] button and set
the save destination

(File Name Extension )
DPP 3 Shooting Date/Time 3 Sequence number B Do not change B
L J
(TR L s T e )
Sort Sequence number
%) Fit to main window 0001 | Save sequence number
" File Name
\_ . Shooting Date/Time Shooting Date/Time
—( ¥ same file name for RAW-+JPEG images ) Month Day Year 3
( __ Copy & Rename Br ) MM-DD-YY 3
MacOS¥ /Users /canon/Desktop Elnser‘l underbar
_ J
Original File Modified File Name
IMG_0001.CR2 DPP_09-13-06_0001.CR2
IMG_0001JPG |DPP_09-13-06_0002.JPC
IMG_0002.CR2 \DPP_09-13-06_0003.CR2
IMG_0002.JPG EDPP_09—13—06_0004JPG
IMG_0003.CR2 iDPP_09—13—06_DGOS.CR2
IMG_0003 JPG — |DPP_09-13-06_0006.JPG
IMG_0004.CR2 éDPP_OQ—lZ—OE_UOD?.CRZ
IMG_0004.JPG DPP_09-12-06_0008.JPC
IMG_0005.CR2 \DPP_09-13-06_0009.CR2
- | a
IMG_0005JPG - |DPP_D9-13-06_0010.JPC £
| = = iy | = — — R

( Cancel )G-Execute)

Sets the new file name

Sets the format of information

in the file name
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB : Standard color space for Windows. Widely used for
the standard color space of monitors, digital
cameras, and scanners.

Adobe RGB : A wider color space than sRGB. Mainly used for
printing for business purposes.

Apple RGB : Standard color space for Macintosh. A slightly

wider color space than sRGB.

ColorMatch RGB : A slightly wider color space than sRGB. Mainly
used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.

Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

y

Color range that can be
seen by the human eye

Gamma White point

value (color temp.)

—— | sRGB 2.2 6500K(D65)
————-- Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
————— ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.

Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Index

A

AdJUuSt JPEG IMAQgES.....coviiiiiiiiiiiiiiiieee e 105

Adjust RAW IMages ... .. 25

AdJuSt TIFF IMages......ccoviiiiiiiiiieeeee e 105

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve Assist)............cccceeeeee. 106
BrightneSsS ..o 107
Click White BalanCe ..........coooiiiuiiiiiiieeiieeeee e 108
(O] ] 1= RSOOSR 107
DynamiCc Range.........uuuiiiiiiiiieiee e 111
HUG e 109
RGB ToOl Palette .......cccoeviiiiiiiiiiee e 130
Saturation ... 109
SNAIPNESS ... e 109
Tone Curve Adjustment...... ..o 110

Adjusting (RAW image)
Apply Adjustments.............eoiiiii s 99
Automatic Adjustment (Tone Curve ASSISt).......cccccceeeeiiiiciiieennnn. 33
BrIghtNess .....eeeieiiiieee e 26
Brightness of Highlights.............cooii e 57
Brightness of Shadows.............coiiiii 57
Click White BalanCe ...........ccuuuuiiiiiiiiiiiiiiiiieeeeneaee 28
Color Saturation ..........cccocoiciiiieii 29
Color TEMPErature ........oooiiiiiiieiiee e 56
(0701 (o] gl o] o [T 29
COlOr WNEE ... 56
(O] 1= 1S SRR 29
Copy AJUSTMENTS ......uuiiiiiiiiiiiiiiiie e eraeeaaeeeeees 99
DynamiC RANGE .......ooooiiiiiiiiii e 57
Filter EffeCt ... 30
MONOCAIOME ... 30
Personal White BalancCe .............ouuevviviiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeee 100
Picture Style ... 26
Picture Style File ........ooooiiii 59
RAW Tool Palette..........uuuueiiiiiiiiiiiiiiieieieeeeeeeeeeeeeeeeeeeee e 130
Save AdJUSTMENTS ......uueiii 99
Tone Curve Adjustment...........cccoii s 58
Toning EffeCt ... 30
B Yo I = 1<) £ (=TT 130, 131
White BalancCe ... 27

Adjustment Contents (ReCIPE)......cccevviiiuiiiiiiiiiiiiiiiiieeeeee e 98, 145
AdODE RGB ... 146
F Y o] o LT R {1 = TP 146
AIrange IMaAgES .....uvvuiei i e e e e eeeaees 20, 21
Auto Lighting Optimizer ... 61
Automatic Adjustment (Tone Curve AsSist)...........eevveveevvveveeeenee. 33, 106
Automatic Dust Erasure Processing.......ccccccvvveveeeveeeeen. 73,75, 116, 117
B
Batch Apply White Balance to Images (Personal White Balance)..... 100
Batch Change the File Name of Images.........ccccccoviiiiiiiiiiiiiiiiine, 103
Batch Convert/Save Images (Batch Process) ...........vvveeevvivvveevveneneee. 101
Batch Process (Batch Save JPEG and TIFF Images)............... 101, 143
Batch Process of Multiple Images
Change File Name ... 103
Convert/Save (Batch Process).........ccooeeuvieeeeeiiiiiiiiiiiieeen 101, 143
Personal White Balance..........ccccccccovviviii 100
Recipe Data .....ccooooviiiiiiiiiii 98
L= 10 = SR 102
Batch Settings Window..........cccooiiiiiiiiiiiiii, 101, 102, 143
Batch Transfer Images ... 102
Batch Transfer Images to Image Editing Software..............cccccvvvvene. 102
Before/After Comparison Display ...............eueeieiiiiiiiiiiiiiiiiiiiieeeeeeeeeeee 53
DIt NUMIDET ... 145
BOOKMAIK ... 51
BrightnNeSS. ..o 26, 107
C
Change File Name............cccoe o, 103
Changing the File Name of Images in the Order in the Main Window .... 103
01 a1<To Q1 1Y, F= T ST 18, 19, 128, 134
Chromatic Aberration Correction ..........cccooeciiiiiiiee i 65
Chrominance Noise Reduction (JPEG, TIFF Images).............c....... 112
Chrominance Noise Reduction (RAW Images) .......ccccceeeeeeiiiiinnnnnnns 62
Click White BalancCe.........cooouiiieiiiieeeeeee e 28, 108
CMYK SIimulation .........ccuveiiieeeieeeiee e 94, 96, 146
Collection WINAOW .......coouniiieeeeeee e 6, 36, 127
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Color Blur Correction ..........ooevieeiieiieee e, 65
(©70] o] g 01 o F- T o SRRSO 146
Color Management (Color Matching)..........cccuveveeiieiiniiiiiieeee e 145
Color Setting of the Monitor (Profiles) .........ceeeveveeviieeiieeeennnen. 94, 95
Color Setting of the Printer (Profiles)...........cevvviiieeveievieeiennneee. 94, 95
[070] (o] gS] o717 TN PPN 146
[CC Profiles ... 145
Color Management (Preferences)........ccccccoovveiiiiiii 94
Color Saturation ... 29
Color Setting of the Monitor (Profiles).................c.cccoc. 94, 95
Color Setting of the Printer (Profiles) .........ccoocoiieeiiiiiiiiiiee, 94, 95
ColOr SPACE ....coeiieiiiiie 146
AdODBE RGB ... 146
APPIE RGB ... 146
Color Space Setting for Each Image ............ccccvvvvevivviiviieeiiieieeeeee, 78
ColorMatch RGB ........ooiiieiii e 146
Default Setting of Color Space ..........euvvveeeeeeeevvieiieeieeeeeeeeeeeee, 94, 95
SRGB ... . e 146
Wide GamUt RGBi..........ouueiiiiieieeeeeeee e 146
Color Space Setting for Each Image..........ooocviiiieiiiiiiniiiieeeeeee e 78
Color Temperature.........cccccoeveeiiiiiie 56
COolOr TONE ..o, 29
(O70] (o] T4 o PSRRI 56
ColorMatch RGB........oooiiiee 146
Compatible Cameras with the Lens Aberration Correction Function.. 63
Compatible Lenses with the Lens Aberration Correction Function..... 63
Compositing IMages ..o, 78
Contact Sheet Printing (Printing a Thumbnail List)...........ccccccceeeines 87
CONTraSst ..o 29,107
Convert to JPEG or TIFF Image and Save.................. 42,101, 136, 143
Convert/save One Image Window ...............ccoeeeeeeeeee, 42,136
Copy Stamp (Image Correction) ..........coeeeeeeeiiiiiiiiiiieeeeeeeieee, 77,120
Copy Stamp Window ..........cceeeveiiiiiiiiiiiieee e 73, 75,116, 118, 142
Copying and Pasting (Applying) Recipes...........ccccveeiiiiiiiiiieeeeeees 99
Correct Images (Copy Stamp Function) .....................o e, 77,120
Creating @ FOIAEN ......cooie e 50

D
Default Noise Reduction Settings............ooooiiiiiiiiiiiiiii 94
Default Setting of Color Space ........ccooeiiiiiieiiieccccccia, 94, 95
Delete IMages .....coooiiiiiiieee e 49
Deleting
Delete IMAagesS ......eeiiiiiiiiie s 49
Delete the Software .............oeeviiiiiiiii e 125
Deleting DPP (Uninstalling) .........cccooiiiiiiiiiicciis 125
Detailed Setting Printing (Printing with Shooting Information)............. 86
Digital Lens OPtimizZEer ............uiiuiiiiiiiiiiiiiiiiiiiiieiseveeveeesseessreeeeeeeeeaee 69
Display
Before/After Comparison Display...........cccccovevviii 53
Enlarged Display (Edit Window) ........cccccccvviiiiiiiiiini 11, 129
Enlarged Display (Quick Check Window) ..........cccccceeeeeennnns 16, 134
Shooting Information Display ...........cceveeviieiiiiiiiiiiiiiieiiieeeeeee, 10, 23
Single IMmage DiSplay ............eueeeiiiiiieiiieeiieieeeeeeeeeeeeeee e 22
Synchronize Edit WiNdOW ............coooiiiiiieee e 54
Thumbnail Display (Main Window).............ccccviiieeiiiinnninnee. 10, 126
Thumbnail Display and Enlarged Display
(Edit Image WindOoW)........ccoiiiiiiiieeiiieeeee e 34, 135
Distortion CorreCtion.........cccoooiiioiicc s 65
Downloading an Image to Your COMPULET .............uuvveivverinniiiriiiiiinnninnns 7
Downloading Images from a Camera ...........cccouvieeeeeiiiiiiiiiieeeeen 7
Downloading Images from a Card Reader...........................ooooe. 9
Downloading IMages .......ccouvuiiciiii e 7
Downloading Images from a Camera...........ccccceeeeeiiiiiiiiieeeceeeeee 7
Downloading Images from a Card Reader .............ccccuvvvvvvvnvvvvininiinnnnnnn, 9
Dust Delete Data ..........ccuuviiiiiiieiiiee e, 73,75, 116, 117
Dust Erasure Processing
Automatic Dust Erasure Processing .........cc.cccoeeeeveeeeeeieeenenn. 73,116
Image Correction (Copy Stamp Function) ...........ccccceeeinnnnnes 77,120
Manual Dust Erasure (Repair Function) ............ccccveeeeeeinnns 75,118
Dynamic Range ........coooiiiii 57, 111
E
Edit Image WindOW........ccooviiiiiiiiee it e e ee e 34, 135
Edit WINAOW... ...t 11,129
EditiNg...cco e, —>Adjusting
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Enlarged Display (Edit WiNdOW) ..........cccuiiiiiiiiiiiiiiieeeee s 11,129
Enlarged Display (Quick Check WiNndOw) ..........ccoooiiiiiiieieeeeiniiieeee. 134
EOS Uy ..o 7
F
False Color REAUCHION .........cooiiiiiiiiiiic e 91
Filter Effect.......cooii i 30
[=T0] (o 1Y g VAVA o o [0,V AN TP 6, 126
G
General Settings (Preferences) ... 91
H
HDR (High Dynamic Range) Images...........ccccoviiiiiiiiiiiiieiiiiiieeeeenn 82
=] S Cover
Highlight Area Warning Indicator ..o 55
HUE .o 109
|
(O O {0 11 P 145
Image Frame Information (Image Marks) ..........cccceveeveeeeieeeieeeeeeeeen. 128
Image Marks (Image Frame Information) ...........ccocoviiiiiiiiininiiinnn. 128
Image Quality
Default Noise Reduction Settings...........cccccceiiiiiiiiiie 94
False Color RedUCLON ...........uviiiiiiiiiiieiiieeeeeeeeeeeeeeeeeeeeeeee e 91
Improve the Quality of an Image (Main Window) ............cccueeeee. 23

Noise Reduction of a JPEG Image (Luminance, Chrominance).. 112
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62

View and Save a RAW Image ............cccc, 91
Image Shooting Information Display .............eevveeiiiiiiiiiiiiiieeiiennnnen. 10, 23
Improve the Quality of an Image (Main Window)..........cccccoviiiiinennnn. 23
J
| = 4 4= To [T PP PPPRPPP 145
L
Lens Aberration CorreCtion ...........ccuuueieiieiiiiiiiiieee e 63
Lens Aberration Correction Window ...........ccooovviiiiiiiiiiiiieieeeinns 65, 138
LENS Tool Palette .........ooeieieieeiiieee e 132
1Y T ST 29

Loading and Pasting (Applying) RecCipes........ccccoeeiiiiiiiiiiiiiiic, 99

Luminance Noise Reduction (JPEG, TIFF Images) ..........cccceeuuvnnen. 112
Luminance Noise Reduction (RAW IMages)........cccvvvvvvvrvverireeeeeeeennnee. 62
M
MaIN WINAOW ... e e e 10, 126
Manual Dust Erasure (Repair Function)...........ccccccvvvvvivvviveeenneee. 75,118
MAP UBIHIEY . 85
MONOCHIOME ...ttt eeeeeeee 30
Filter EffeCt.. ..o 30
ToniNg EffeCt ... 30
Move Or COPY FOIErS ......coooiiiiiiiiiiiiiee e 51
Move or COPY IMAGES ......uuuuuiiiiiiiiiiiiiiiiiiiiiiiitiirereresreereeeereeesreeeeeeeeeeees 50
N
Noise Reduction (JPEG or TIFF Image)........ccccccevuereeirnerinneniniiininnnns 112
Noise Reduction (RAW IMage) ........cccooriiiiiiiiiiiiiiiiieeeeeee e 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ....... 112
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview WIiNAOW.........coooiiiiiiiiiiieeeeeeeee e 62, 112, 133
NR/ALO ToOl Palette ......ccoveeiiiiieieeee e 131
(0]
Organize IMages ..o 49
Organizing IMagESs ........uuuiiiiiiiiiiiiie e 49
Create @ FOIder.........uuiiiiieeeeeeee e 50
Delete IMagesS......ccovvieeeece e 49
Move or Copy Folders.........ccccoiiiiiii 51
Move or Copy IMages........oovvviiiiiiiieeee 50
Register Folders as Bookmarks............cccccoiiiiiiiiiieeiiieeen 51
P
Peripheral lllumination Correction .............cccccvvvviivviiiieeeiiiiiiieeeeeeeeeeee, 65
Personal White Balance ..........cccooooiiiie 100
PiICture SEYIE ..o 26
Picture Style File......ccooiiii e 59
Prefer@nCes ... . 90
(0] (ol Y/ F=TaT=To [T 1 1T o | AU PP 94
General SettiNGS . ..vvveiiiiei e 91
Tool Palette ... 93
VieW Settings ..oooooeiieee e 92
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Printing
Printing a Thumbnail List (Contact Sheet Printing) ..................... 87
Printing One Sheet of Paper ..., 14, 49
Printing Using Easy-PhotoPrint...........ccccviiiii e 46
Printing Using Easy-PhotoPrint EX ..., 43
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RECIPE ... e 98, 145
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Thumbnail Display (Main Window) .............eeeieiiiiiiiiiieeeeeee 10, 126
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Transfer
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.

Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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